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ЗАГАЛЬНІ ПОЛОЖЕННЯ 

 

Курс «Інформатика із основами геоінформатики» викладається студентам 

2-3 курсу денного відділення. Ця дисципліна є фундаментальною складовою у 

підготовці бакалаврів географії, особливо враховуючи новий стандарт вищої 

освіти, який має ставити університетський освітній рівень у відповідність вимо-

гам сучасного інформаційного суспільства.    

За сутністю цей курс має двоєдиний зміст: по-перше, в ньому розглядаєть-

ся міжгалузева дисципліна, яка вивчає структуру та загальні властивості даних і 

інформації, а також методи і (технічні) засоби її створення, перетворення, збері-

гання, передачі та використання в різних галузях людської діяльності; по-друге, 

саме в рамках цього курсу студенти-географи вперше знайомляться із новітніми 

дослідницькими засобами своєї предметної галузі – геоінформаційними систе-

мами та технологіями.  

Сам термін інформатика виник в 60-х рр. минулого сторіччя у Франції для 

назви предметної галузі, яка займалася автоматизованою обробкою інформації 

за допомогою електронних обчислювальних машин. Французький термін утво-

рений шляхом з’єднання дефініцій ―інформація‖ і ―автоматика‖, тобто означає 

―інформаційна автоматика або автоматизована переробка інформації‖. В англо-

мовних країнах цьому терміну відповідає його повний синонім computer science 

(наука про комп’ютерну техніку). Існує забагато визначень інформатики, що 

пов’язано з багатогранністю її функцій, можливостей, форм, методів. Універси-

тетський курс, до якого відносяться дані Методичні вказівки, розглядає базовим 

наступне визначення: «Інформатика – комплекс науково-практичних дисциплін, 

що вивчають все аспекти здобуття, зберігання, перетворення, передачі і викори-

стання інформації».  

 Студентам окремо пояснюється, що відповідно до потреб становлення і 

розвитку нових знань про природу матеріального світу з'явилася наука, що ви-

вчає структуру й загальні властивості інформації – наукова інформатика.  Пред-

метний же напрямок, що поєднує інформатику,  обчислювальну техніку й  ав-

томатизацію став називатися прикладною інформатикою. Поступово студенти 

отримують знання про те, як на базі прикладної інформатики в деяких, най-

більш запитаних предметних галузях стала розвиватися  галузева інформатика. 

Одним з найбільш яскравих прикладів цієї дисципліни є геоінформатика.  Це 

науковий напрямок, який займається вивченням законів, методів і способів на-



 5 

копичення, обробки й передачі геолого-географічної інформації за допомогою 

ЕОМ і інших технічних засобів. 

Опанування знаннями, вміннями та навичками саме із інформатики та гео-

інформатики є важливим для студентів-географів не тільки з точки зору універ-

ситетської освіти взагалі, але й для подальшого успішного виходу на ринок пра-

ці інформаційних технологій, який сьогодення розвивається в нашій державі 

швидше за будь-який інший.    

 

Мета курсу: Набуття студентами знань, вмінь і навичок щодо роботи із 

базовими апаратними і програмними засобами обчислювальної техніки для об-

робки та аналізу загальної і предметної інформації. Досягнення цієї мети сприя-

тиме ефективній праці випускників-географів у 1) народній освіті, у сферах 2) 

соціально-економічної географії і фізичної географії, 3) природокористування і 

забезпечення екологічної і техногенної безпеки населення. 

 

Завдання курсу: 

 сформувати у студентів уявлення про сутність і роль феномену інформації 

в сучасному світі та про можливості інформаційно-комунікаційних технологій у 

створенні, обробці та розповсюдженні інформації;  

 сформувати у студентів знання та систематизувати для них прийоми і ме-

тоди пошуку, створення, збереження, відтворення, обробки й передавання даних 

та інформації засобами обчислювальної та комунікаційної техніки;| 

 ознайомити студентів з основними категоріями апаратних засобів обчис-

лювальної техніки; 

 ознайомити студентів з основними категоріями програмних засобів обчис-

лювальної техніки;   

 ознайомити студентів і опанувати базові принципи побудови архітектури і 

платформ обчислювальних систем;  

 студентам засвоїти і опанувати методично обґрунтовані принципи процесів 

взаємодії інформації, даних і методів; 

 підготувати студентів до самостійного використання                                         

електронних та дистанційних засобів навчання у процесі подальшого вивчення 

різних навчальних дисциплін із геоінформаційних систем та технологій. 
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Рівні компетентності студентів: 

 У результаті вивчення даного курсу студенти повинні знати:                  

 особливості феномену інформації в сучасному світі та можливості ін-

формаційно-комунікаційних технологій, які використовуються у створенні, об-

робці та розповсюдженні інформації; 

  методи пошуку, створення, збереження, відтворення, обробки й переда-

вання даних та інформації засобами обчислювальної та комунікаційної техніки; 

 основні категорії програмних та апаратних засобів; 

 базові принципи побудови архітектури і платформ обчислювальних си-

стем; 

 методично обґрунтовані принципи процесів взаємодії інформації, даних 

і методів; 

 

По результатах виконання лабораторних занять курсу студенти повинні вмі-

ти:   

 працювати із засобами персональної обчислювальної техніки, які будуть 

використовуватися майбутніми фахівцями в навчальній і методичній роботі зі 

своєї предметної області;  

 демонструвати первинні навички та вміння дослідницької роботи із ін-

форматики та геоінформатики шляхом участі у виконанні та захисті ко-

лективних та індивідуальних проектів із обробки первинних даних щодо загаль-

ної та спеціалізованої, зокрема – просторово-координованої, інформації;  

  свідомо використовувати сучасні комп'ютерні інформаційні засоби та 

технологій для створення та опрацювання текстової, числової та графічної інфо-

рмації;  

 користуватися головними елементами функціональності базових ГІС-

платформ через їх графічний інтерфейс користувача.  
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СТРУКТУРА КУРСУ 

Тематичний план: 

 

Модулі та 

теми 

Години: 

 

Усього  

у тому числі 

лекції практичні лабораторні інд.заняття самостійна 

робота 

Модуль 1 

Тема 1.1.  6 2 - 2 - 4 

Тема 1.2. 4 2 - - - 2 

Тема 1.3. 6 2 - 2 - 4 

Тема 1.4. 8 2 - 2 - 4 

Разом за  

модулем 1 

 

28 

 

8 

 

- 

 

6 

 

- 

 

14 

     Модуль 2 

Тема 2.5. 8 1 - 2 - 6 

Тема 2.6. 12 1 - 6 - 6 

Тема 2.7. 4 2 - - - 2 

Разом за  

модулем 2 

 

26 

 

4 

  

8 

  

14 

Модуль 3 

Тема 3.8. 10 2 - 4 - 4 

Тема 3.9. 14 2 - 6 - 6 

Тема 3.10. 4 2 - - - 2 

Тема 3.11. 16 2 - 6 - 10 

Тема 3.12. 16 2 - 6 - 10 

Разом за  

модулем 3 

 

64 

 

10 

  

22 

  

32 

 Модуль 4 

Тема 4.13. 10 2 - 6 - 2 

Тема 4.14. 10 2 - 6 - 4 

Тема 4.15. 19 4 - 12 - 6 

Разом за  

модулем 3 

 

44 

 

8 

  

24 

 12 

Усього годин  162 38  60  72 
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Теми семінарських занять (колоквіумів): 

№ 

з/п 

 

Назва теми 

Кількість 

годин 

1 Колоквіум по лекційним темам 1.1.-1.4. – 2.5.-2.7. 2 

2 Колоквіум по лекційним темам 3.8.-3.12. – 4.13.-4.15. 2 

...   

 

Теми лабораторних  занять: 

№ 

з/п 

 

Назва теми 

Кількість 

годин 

1 2 3 

1 Знайомство із персональним комп’ютером і із компонентами 

системного блоку. Знайомство із основними прийомами кори-

стування ПК в операційних середовищах Windows XP та Win-

dows Vista. Настроювання КС через програму Setup.  

 

 

 

2 

2 Перше знайомство із засобами ГІС: знайомство із електрон-

ним переглядачем карт ArcExplorer. 

 

2 

3 Більш детальне знайомство із графічною оболон-

кою/операційною системою Windows XP: диспетчер програм, 

диспетчер файлів, вбудовані додатки Wіndows (редактор 

NotePad, графічний редактор PaintBrush), знайомство і перші 

навички роботи з текстовим процесором Word; вивчення при-

йомів роботи із об’єктами у середовищі Windows.  

 

 

 

 

 

4 

4 Знайомство із переглядачем карт – базою географічних  даних 

пакетом Amiglobe  

 

2 

5 Aлгоритмічна мова MS QBasic: алгоритми лінійної структури 

та такої, що розгалужується  

 

2 

6 Початок роботи в підсистемі Аналіз просторових даних сис-

теми автоматизованого гідролого-геоморфологічного моде-

лювання під ОС MS-DOS та MS Windows 

 

 

4 

7 Aлгоритмічна мова MS QBasic: алгоритми, які реалізуються за 

допомогою циклів типу «ДЛЯ»  

 

2 

8 Знайомство  з геоінформаційною системою МapІnfo Profes-

sional:  Основи картографування  

 

2 

9 Робота із растровими та векторними графічними редакторами. 

Розвинуті засоби роботи із MS Word, MS Excel, MS Power Point  

 

8 
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10 Основи роботи із ГІС-платформою ArcView 3.x – базові при-

йоми роботи Користувача 

 

4 

11 Aлгоритмічна мова MS QBasic: алгоритми, які реалізуються за 

допомогою вкладених циклів типу «ЯКЩО»  

 

2 

12 Створення графіки в середовищі програмування MS QBasic 4 

13 Вступ до візуального програмування – Visual Basic  4 

14 Поняття про Visual Basic for Application (VBA)  2 

15 Продовження знайомства  з геоінформаційною системою 

МapІnfo Professional: Геокодування, Креслення, Редагування, 

Створення Проектів     

 

 

4 

16 Робота із пакетом геостатистичного моделювання Vertical 

Mapper 

 

4 

17 Продовження роботи із ГІС-платформою ArcView 3.x – Робота 

із просторовими даними, Запити до даних, Менеджмент таб-

лиць, створення проекту із муніципального менеджменту 

 

 

8 

 Разом 60 

 

Самостійна робота: 

№ 

з/п 

Назва теми Кількість 

годин 

1 Практикуми 1-3 із MS Word  6 

2 Створення проектів «Сан-Дієго», «Ріо» та «Прага» в середо-

вище Переглядача Карт ArcExplorer 

 

8 

3 Aлгоритмічна мова MS QBasic: алгоритми лінійної структури 

та такої, що розгалужується – домашні завдання 

 

16 

4 Aлгоритмічна мова MS QBasic: алгоритми, які реалізуються за 

допомогою вкладених циклів типу «ДЛЯ» - домашні завдання 

 

12 

5 Створення графіки в середовищі програмування MS QBasic – 

домашні завдання 

 

10 

6 Арифметичні основи інформаційних технологій – домашні за-

вдання 

 

8 

6 Вступ до візуального програмування – Visual Basic – домашні 

завдання 

 

4 

7 Поняття про Visual Basic for Application (VBA) - домашні за-

вдання 

 

4 

 Разом  72 
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ЗАГАЛЬНИЙ ЗМІСТ КУРСУ 

 

МОДУЛЬ 1. Вступ до інформатики. Кодування інформації. 

 

Тема 1.1.  Вступ до інформатики. Загальна характеристика понять 

“Інформація” та “Інформатика”. Початкові уявлення про геоінформатику  

1. Що таке інформатика й інформація? Інформатика – загальне визначення 

поняття. Інформація – загальне визначення поняття 

2. Дані й інформація в матеріальному світі. 

3. Кількісна міра інформації. 

4. Початкові уявлення про геоінформатику.      

5. Деякі базові поняття щодо програмного та апаратного забезпечення. 

Розкриваються поняття ―Інформаційна картина буття‖,  ―Інформаційна кар-

тина світу‖, ―Інформаційне суспільство й інформаційна культура‖. Інформатика 

як галузь науки, що вивчає структуру і загальні властивості наукової інформації, 

а також питання, зв’язані з її збором, збереженням, пошуком, переробкою, пере-

творенням, поширенням і використанням у різних сферах людської діяльності. 

Як головна задача інформатики вказується систематизація прийомів і методів 

роботи з апаратними і програмними засобами обчислювальної техніки. 

Викладаються головні форми подання інформації. Подаються різні методич-

ні підходи щодо визначення кількості інформації. Кількість інформації оціню-

ється як міра зменшення невизначеності через одиниці виміру кількості інфор-

мації. Подаються початкові засади геоінформатики - наукового напрямку, який 

займається вивченням законів, методів і способів накопичення, обробки й пере-

дачі геолого-географічної інформації за допомогою ЕОМ і інших технічних за-

собів.Надається глосарій головних понять щодо програмного та апаратного за-

безпечення та загальна функціональна структура обчислювальної системи.  

  

Тема 1.2. Головні складові феномену інформації. Співвідношення між 

інформацією та інформатикою. Основи логіки 

1. Феномен   інформації – що це таке? 

      1.1. Визначення інформації. 

      1.2. Кількісна міра інформації – додаткові пояснення. Що таке величи-

на чи кількість інформації. Формула Шенона. Біт і байт. Експер-

тні методи оцінки інформації і становлення нових мір інформації. 

      1.3. Класифікація інформації:  
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             - за способом кодування,  

             - за сферою виникнення,  

             - за способом передачі і сприйняття,  

             - за суспільним призначенням. 

      1.4. Властивості інформації: атрибутивні, прагматичні, динамічні. 

2. Що таке інформатика? 

      2.1. Визначення інформатики 

      2.2. Головні складові інформатики. Теоретична інформатика. Семіо-

тика. Кібернетика. Аналогова і цифрова обробка інформації. 

      2.3. Деякі визначення. 

3. Основи логіки.  

 

Тема 1.3.  Кодування символьної інформації 

1. Форма і мова подання інформації; основи кодування інформації. 

2.  Історія засобів передачі термінових повідомлень. 

3.  Основи двійкового кодування інформації. 

4. Розвиток засобів кодування в комп’ютерній техніці. 

     Термінові повідомлення грають найважливішу роль в інформаційній струк-

турі держави. Крім самого повідомлення і способу його передачі, існує  ще один 

компонент – перетворення інформації, тобто кодування. Дійсним проривом у 

кодуванні символьної інформації стало її семи-бітне кодування, коди ASCII та 

UNICODE. Надаються приклади інших систем кодування. 

  

Тема 1.4.  Кодування графічної інформації 

1. Поняття про код. Переваги графічного подання інформації у порівнянні  з 

табличним. 

2. Аддитивна модель RGB. 

3. Відеокарта комп’ютера. 

4. Субтрактивна модель CMYK. 

5. Стиснення інформації і лініатура растру. 

6. Кодування графічної інформації – підведення підсумків.  

Пояснюється, що у швидкості аналізу графічної інформації полягає перева-

га людини над комп’ютером. Розглядаються: особливості комп’ютерної графі-

ки: змішування кольорів – Адитивна система кодування RGB. Обговорюється 

управління комп’ютерною графікою – будова відеокарти комп’ютера. Виклада-

ються поняття Кольоровий Кубу та Субтрактивної модель передачі кольору. 
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Пояснюються методи опису графічних даних (растр, вектор). Растрові і векторні 

графічні редактори: розглядаються їх розходження і переваги.  

Графічний редактор подається як комплекс програм, що дозволяє створю-

вати і редагувати зображення на екрані комп’ютера: малювати лінії, розфарбо-

вувати області екрана, створювати надписи  різними шрифтами, обробляти зо-

браження, отримані за допомогою сканерів. Додатково пояснюється як деякі ре-

дактори забезпечують можливість одержання зображень тривимірних об’єктів, 

їхніх перетинів і розворотів.  

 

Предметні вимоги до знань і навичок студентів відповідно модулю 1: 

 знати що таке інформатика й інформація;  

 мати уявлення про дані й інформацію в матеріальному світі; 

 отримати початкові уявлення по кодування символьної інформації; 

 отримати початкові уявлення по кодування графічної інформації; 

 отримати початкові уявлення про геоінформатику; 

 вміти працювати з головними графічними редакторами; 

 вміти застосовувати елементарні навички роботи з деякими ГІС-

платформами.       

 

МОДУЛЬ 2. Файли і структури даних. Апаратна конфігурація комп’ютера  

 

Тема 2.5.  Файли і структури даних. 

1. Файли як одиниці зберігання даних і файлові структури. 

2. Операції з даними. 

3. Основні структури даних:  

- лінійні, 

- табличні,  

- ієрархічні;  

- впорядкування структур.  

4. Файлова система 

 Обговорюються одиниці збереження даних.  При збереженні даних необ-

хідно вирішувати дві проблеми: 1) як зберегти дані в найбільш компактному 

виді і 2) як забезпечити до них зручний і швидкий доступ. Для забезпечення до-

ступу необхідно, щоб дані мали упорядковану структуру, а при цьому утворю-

ється «паразитне навантаження» у виді адресних даних. Без них не можна одер-

жати доступ до потрібних елементів даних, що входять у структуру.  
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     Подається поняття файлової структури. Пояснюється, що ключовою є ви-

мога унікальності імені файлу – без цього неможливо гарантувати однознач-

ність доступу до даних. У засобах обчислювальної техніки вимога унікальності 

імені забезпечується автоматично – створити файл з ім’ям, тотожним уже наяв-

ному, не може ні користувач, ні автоматика. Збереження файлів організовується 

в ієрархічній структурі, що називається файловою структурою.  

Розглядаються головні структури даних.  Існує три основних типи структур 

даних:лінійна, ієрархічна і таблична. Лінійні структури (списки даних, вектори 

даних). Список – як найпростіша структура даних, що відрізняється тим, що 

кожний елемент даних однозначно визначається своїм номером у масиві. Таб-

личні структури (таблиці даних, матриці даних) – елементи даних визначаються 

адресою осередку, що складається не з одного параметра, як у списках, а з декі-

лькох. Окремо розглядаються ієрархічні структури даних. 

 

Тема 2.6.  Архітектура та структура обчислювальної системи. Класи-

фікація комп’ютерів. Базові команди та їх виконання 

1. Загальні поняття про архітектуру та структуру комп’ютерів. 

2. Принципи сучасної архітектури комп’ютерів. 

3. Класифікація комп’ютерів:  

- за призначенням; 

- за рівнем спеціалізації; 

- за розміром та сумісністю.  

4. Загальна будова комп’ютерів як базова апаратна конфігурація. 

5. Базові команди та їхнє виконання. 

Через архітектуру і структуру розглядається функціональна організація 

комп’ютера. Пояснюється, що комп'ютер - це електронний пристрій, який вико-

нує операції введення інформації, зберігання та оброблення її за певною про-

грамою, виведення одержаних результатів у формі, придатній для сприйняття 

людиною. Представлені принципи сучасної архітектури комп’ютерів: принцип 

програмного управління, принцип однорідності пам’яті, принцип адресності. 

Послідовно розглядаються ключові вузли апаратного забезпечення: проце-

сор і внутрішня (оперативна) пам’ять; пристрої введення інформації; пристрої 

виведення інформації; мультимедіа комп’ютера; основні типи носіїв інформації 

та їх найважливіші характеристики.  

Пояснюється програмне керування комп’ютером. Здійснюється знайомство 

з особливостями операційної системи комп’ютера. Розглядаються комп’ютерні 
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віруси: методи поширення, профілактика зараження. Розглядається прикладне 

програмне забезпечення. Викладаються історія і перспективи розвитку 

комп’ютерної техніки, правила технічної експлуатації комп’ютерів, техніка без-

пеки і санітарно-гігієнічні норми при роботі на комп’ютері.  

Пояснюється питання при рівні програмного забезпечення та класифікацію 

прикладних програмних засобів. Окремо пояснюються класифікація службових 

програмних засобів та поняття про інформаційне й математичне забезпечення 

обчислювальних систем.  

Розглядаються засади класифікації комп’ютерів. Послідовно пояснюється 

класифікація: за призначенням, за рівнем спеціалізації, за розміром та сумісніс-

тю. Детально пояснюється зміст базових команд як елементарних операцій 

комп’ютера. 

 

Тема 2.7. Історія розробки комп’ютерів. Додаткові відомості про класи-

фікацію апаратного забезпечення. 

1. Історія розробки ЕОМ. 

2. Додаткові відомості про класифікацію апаратного забезпечення.  

Надається історична довідка створення обчислювальних пристроїв. Розгля-

даються інші принципи класифікації комп’ютерної техніки аніж ті, що обгово-

рювалися у темі 2.6. Детально пояснюється будова і функціональність 

комп’ютерів першого – третього поколінь, та викладаються основні характерис-

тики ЕОМ 4-го та перехідного до 5-го поколінь. Ставиться питання: якими ма-

ють бути комп’ютери 6-го покоління? Додатково розглядається класифікація 

комп’ютерів за умов експлуатації, і характеру використовування.  надаються 

основні уявлення про портативні комп’ютери, «айпеди» та «хмарові технології». 

 

Предметні вимоги до знань і навичок студентів відповідно модулю 2: 

 знати що таке файли і структури даних;  

 знати про файлову систему; 

 знати особливості структури комп’ютерів і головні типи його архітектури; 

 знати головні принципи різних комп’ютерних класифікацій;  

 вміти виконувати базові команди; 

 знати історію розробки апаратних комп’ютерних засобів. 
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МОДУЛЬ 3: Алгоритмізація і програмування. Алгоритмічні мови 

     

Тема 3.8.  Алгоритмізація і програмування. Системи числення і основи 

алгоритмізації.  

1. Алгоритм і основні алгоритмічні конструкції. 

2.  Методи розробки алгоритмів.  

Розглядається поняття алгоритм і його властивості. Обговорюється форма-

льне виконання алгоритмів. Послідовно пояснюються: основні алгоритмічні 

конструкції; лінійний алгоритм; алгоритм, що розгалужується; циклічний алго-

ритм; допоміжні алгоритми. Окремо подаються розробка алгоритмів методом 

послідовної деталізації (зверху вниз) та розробка алгоритмів складальним мето-

дом (знизу нагору). 

 

Тема 3.9.  Редактор алгоритмічної мови MS QBasic (Бейсик, Quick Basic, 

QBASIC ).  Програмування в середовищі MS QBasic 

1. Вступ до алгоритмічної мови.  

2. Основні системні команди, алфавіт і конструкції мови Бейсик. 

3. Деякі оператори мови Бейсик. Базові оператори. Переходи в програмі 

4. Структурна організація алгоритмів. 

5. Середовище програмування алгоритмічної мови Quick Basic. 

6. Можливості редактора програмування Quick Basic. 

В рамках цієї теми впроваджується введення в алгоритмічну мову, розгля-

даються основні системні  команди, конструкції мови і  оператори, середовище 

програмування, приклади програм, можливості відповідного редактора. 

Окремо розглядаються наступні поняття:    

 Інтерпретатор QBASIC. Робота з редактором. Робота з меню. Безпосереднє 

виконання команд. Робота з декількома вікнами. Настроювання QBASIC. Довід-

кова система. Функції користувача. Відладка. Проста графіка. Перемінні в 

QBASIC. Запис чисел та строк. Коментування. Умовні обчислювання. Оператор 

циклу. Переривання роботи програми. Масиви. Функції. Робота з графікою й 

файлами.   

 

Тема 3.10.    Об’єктно-орієнтоване програмування. Основи Visual Basic 

1. Засади об’єктно-орієнтованого програмування. 

2. Головні принципи програмування через алгоритмічну мову у середовищі 

операційної системи Windows (на прикладі Visual Basic). 
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Викладаються основи об’єктно-орієнтованого програмування. Розгляда-

ються об’єкти в середовищі Windows & Office. На прикладах здійснюється ство-

рення макросів у офісних додатках (Word, Excel). Викладаються основи АМ 

Visual Basic. Розглядається кодування різних алгоритмів мовою Visual Basic. 

Здійснюється розробка проекту в середовищі Visual Basic. Робиться досліджен-

ня прикладів інформаційної моделі на комп’ютері.  

 

Тема 3.11.   Арифметичні  засади  інформаційних технологій (ІТ) 

1. Загальні поняття про систему числення. 

- Принципи десяткової системи числення. 

- Принципи двійкової системи числення. 

2. Системи числення, що  використовуються в інформаційних технологіях 

3. Деякі арифметичні операції в позиційних системах числення. 

4. Подання в ІТ цілих чисел. 

5. Подання в ІТ дійсних чисел. 

Виконується подальше вивчення систем числення, особливо тих, які засто-

совуються при роботі із комп’ютером. Розглядаються арифметичні операції в 

різних позиційних системах числення. Вивчається подання у комп’ютері цілих 

чисел та подання у комп’ютері дійсних чисел. Здійснюється детальний розгляд 

арифметичних складових  комп’ютерних розрахунків. 

 

Тема 3. 12.   Логічні  засади інформаційних технологій 

1. Основні поняття про алгебру логіки. 

2. Логічна формула. Зв'язок між алгеброю логіки і двійковим кодуванням.  

Вид запису в пам'яті комп'ютера і в регістрах процесора даних і команд. 

3. Логічний елемент комп'ютера і логічні схеми. 

4. Рішення логічних задач:  

        табличним способом,  за допомогою міркувань, табличним способом. 

Викладаються логічні основи інформаційних технологій. Детально розгля-

дається Булева алгебра логіки. Пояснюються логічні формули і методи їх спро-

щення. Окремо пояснюється схема перемикача, її синтез та аналіз. Надаються 

приклади рішення логічних задач: 1) способом спрощення логічних формул, 2) 

способом міркувань, 3) табличним способом. 
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Предметні вимоги до знань і навичок студентів відповідно модулю 3: 

 знати про алгоритми і основні алгоритмічні конструкції;  

 вміти застосовувати методи розробки алгоритмів; 

 вміти програмувати в середовищі алгоритмічної мови MS QBasic; 

 мати уявлення про об’єктно-орієнтоване програмування та про програмуван-

ня в операційному середовищі  Windows; 

 знати головні принципи різних систем числення;  

 вміти застосовувати арифметичні операції через інформаційні технології; 

 знати Булеву алгебру логіки, її закони, основні логічні формули; 

 вміти розв’язувати логічні задачі.  

 

МОДУЛЬ 4: Геоінформаційні системи, комп’ютерні мережі та комунікації 

 

Тема 4. 13.   Геоінформаційна концепція сучасної географії  

1. Сучасний географічний підхід до дослідження природно-антропогенного 

довкілля – методологія геоінформаційних систем (ГІС)  

2. Поняття геоінформаційної системи. Особливості досліджень на підста-

ві ГІС-аналізу. 

3. Математичний апарат в середовищі ГІС (на прикладі топології і графіч-

них примітивів). 

4. ГІС для предметних та регіональних проектів.  

Здійснюється вивчення основ  роботи з ГІС, як із системами апаратно-

програмних засобів і алгоритмічних процедур, створених для цифрової підтри-

мки, поповнення, управління, маніпулювання, аналізу, математико-

картографічного моделювання і образного відображення географічно-

координованих даних. Розглядаються геопросторові дані, які  подають інформа-

цію,  що ідентифікує географічне місцерозташування й  властивості  природних 

або штучно створених об'єктів,  а також їхніх границь на землі. Така інформація  

може  бути  отримана  за  допомогою  (крім  інших   шляхів), дистанційного   

зондування,  картографування  й  різних  видів зйомок. Географічні дані містять  

чотири  інтегрованих  компоненти: місцерозташування, властивості й характе-

ристики, просторові  відношення, час. Топологія в середовищі ГІС подається як 

набір правил і відносин, що у сукупності з інструментами і технологіями реда-

гування дозволяють більш точно моделювати в базі геоданих – БД ГІС - реальні 

просторові відносини. 
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Тема 4.14. Комп’ютерні комунікації і мережі  

1. Технології комп’ютерних комунікацій. 

2. Комп’ютерні мережі.  

     Викладаються особливості основних інформаційних сервісів комп’ютерних 

мереж. Пояснюється будова локальних комп’ютерних мереж. Розглядаються: 

структура глобальної комп’ютерної мережі Інтернет; адресація в Інтернет; про-

токол передачі даних TCP/IP; типи модемів. Вивчаються основи функціонуван-

ня електронної пошти. Послідовно розглядаються: телеконференції; основи тех-

нології WWW; мережні файлові архіви.  

 

Тема 4.15. Засади ГІС (продовження): Просторові дані та ГІС-аналіз  

1. Додаткові відомості про географічні інформаційні системи. 

2. Типізація просторових об’єктів.  

3. Особливості ГІС-аналізу. 

Поглиблюються вже існуючі уявлення про просторові і географічні інфор-

маційні системи. Розглядаються особливості комп’ютерного картографування. 

Розглядається типізація дискретних та континуальних просторових об’єктів. 

Обговорюються загальні задачі ГІС-аналізу: аналіз місцеположення об’єктів; 

аналіз розподілу числових показників; побудова карт щільності; пошук об’єктів 

усередині області; аналіз сусідства; картування змін у довкіллі; визначення про-

сторових атрибутів об’єктів; розподіл об’єктів по категоріях; пошук та визна-

чення закономірностей розподілу; підготовка до побудови бази геоданих; візуа-

лізація результатів. Розгляд теми закінчується створенням учбових проектів в 

середовищах MapInfo та ArvView. 

 

Предметні вимоги до знань і навичок студентів відповідно модулю 4: 

 знати особливості ГІС-платформ MapInfo Professional та ArcView 3.x;  

 вміти впроваджувати ГІС-аналіз; 

 вміти програмувати в середовищі алгоритмічної мови MS QBasic; 

 знати певні елементи математичного апарату в середовищі ГІС, зокрема, то-

пологію та графічні примітиви; 

 знати головні принципи впровадження ГІС-проектів;  

 вміти застосовувати технології комп’ютерних комунікацій; 

 знати структуру комп’ютерних мереж (локальних і глобальних); 

 знати типізацію просторових об’єктів та головні особливості ГІС-аналізу. 
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нию баз геоданных: Пер. с англ. - К.: ЗАО ЕСОММ Со, 2004. 
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РЕКОМЕНДОВАНИЙ ПОХВИЛИННИЙ РОЗКЛАД  ЗМІСТУ 

ЛАБОЛАТОРНИХ ЗАНЯТЬ 

 

Перший семестр вивчення курсу  

(перший та більша частина другого модулі)  

 

Лабораторне заняття 1.1 

1. Перше знайомство із алгоритмічною мовою (АМ) MS QuickBasic.  Де-

монстрація можливостей графіки в цій АМ  – робота із файлом Tutor4.qbp: сту-

денти мають переглянути теорію щодо показникової функції  вдома та зробити 

через вказаний файл тест на показникову функцію в аудиторії наступного разу ~ 

15 хвилин.  

2. Знайомство із: 1) списком літератури по курсу та 2) домашнім завдан-

ням по вивченню теоретичного матеріалу; 3) знайомство із домашнім завданням 

№ 1 із програмування: рішення квадратного рівняння загального виду; відповід-

но п. 3) коротке пояснення щодо складання алгоритмів на природничій мові та 

про накреслення блок-схем   ~ 15  хвилин. 

3.  Знайомство із програмним забезпеченням MS Office.  Нашвидку  звер-

нення до текстового процесору MS Word із  поясненням різниці між текстовим 

процесором і текстовим редактором. Запропонувати студентам набрати (з твер-

дої копії) документ Перший Раз в комп'ютерному класі. Правила поведінки. 

Оцінити швидкість текстового набору кожного. Документ має бути збережений 

на магнітному носії. Розповсюдити методички Практикум № 1 із MS Word – ре-

дагування електронних документів: студенти мають прочитати текст і набрати 

його, дотримуючись правил форматування   ~ 20 хвилин. 

4.  Перше знайомство із засобами геоінформатики – студентам треба знай-

ти на Робочому столі піктограму Mapgallery, переглянути кожну електронну ка-

рту із меню World та, за можливістю – із меню Country та Region. Кожна елект-

ронна карта буде пояснена та обговорена із студентами. ~ 20 хвилин. 

5.  Перше знайомство із ГІС-Переглядачем карт ArcExplorer 2.0 – початок 

виконання проекту Сан-Дієго: 1) запустити ярлик із Робочого столу; знайти в 

директорії \ESRI\ArcExplorer 2.0\Sandiego проект Sandiego і почати його вико-

нання за допомогою роздруківок із підручника Практична геоінформатика (c. 

16-21). Пояснити принципи побудови цифрових карт; студентам необхідно на-

креслити в зошитах відповідну схему (рис. I-9 із Практичної геоінформатики) 

~ 20 хвилин. 
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Лабораторне заняття 1.2 

1. Перевірка домашнього завдання (ДЗ) № 1. Студенти мають зачитати 

текст на природничій мові, продемонструвати блок-схему алгоритму і заванта-

жити файл *.BAS із власною програмою .  

2. Викладач має продемонструвати студентам авторське рішення програ-

ми  із ДЗ № 1. Пояснити різницю запису програми: запис у «класичному Бейси-

ку», запис у режимі remlines и т.д. – три авторські файли .BAS додаються. 

3. Роздати студентам методичні матеріали для конспектування: 1) тексту 

алгоритму на природничій мові; 2) блок-схеми, 3) тексту програми, рішення 

яких пропонуються у файлі –необхідно  набрати три програми у три різних фай-

ли. Власноруч студенти мають перевірити роботу запропонованих програм. Пп. 

1-3 ~ 35   хвилин.  

4. Розповсюдити Adobe Acrobat файл QBasic_Basic, в якому подаються за-

сади цієї алгоритмічної мови – студенти мають швидко його переглянути, коро-

ткого законспектувати, за бажанням можуть списати його на свої магнітні носії 

~  15   хвилин.  

5.  Задати домашнє завдання № 2  (складення програми для визначення 

сторони, периметра та площі трикутника за відомими катетами), коротко 

пояснити. Термін виконання -  тиждень  ~ 5 хвилин.  

6. Виконання комп’ютерного тесту на показникову функцію – програма  

TUTOR4.qbp. – на початку тестового завдання студенти мають передивитися те-

орію, а потім два рази виконати тест на оцінку ~ 20 хвилин. 

7.  Продовження знайомства із засобами геоінформатики: Закінчення ви-

конання проекту Сан-Дієго відповідно до вказівок на сторінках 16-21 підручни-

ка ~ 15 хвилин.  

 

Лабораторне заняття 1.3 

1. Перевірка та оцінювання виконання ДЗ № 2.  

2. Завантаження тексту авторської програми й демонстрація її роботи. 

Розповсюдження серед студентів методичних матеріалів щодо ДЗ № 2. Пп. 1-2 ~ 

35 хвилин.  

3.  Задати домашні завдання № 3 (зробити програму, яка обчислює добу-

ток чисел від 1 до 8), і № 4 (треба написати програму із використанням опе-

ратору умовного переходу IF… THEN (Якщо… Тоді) програму, яка виводить на 

екран повідомлення про вірне або невірне значення добутку «2*2=» як резуль-

тат вводу цього числа із клавіатури), коротко пояснити ~ 10 хвилин.  
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4.  Продовження знайомства із засобами геоінформатики. Робота  із паке-

том Рельєф-Процесор –  системою геологічного і гідролого-геофізичного моде-

лювання, зокрема із підсистемою Аналіз Просторових Даних (файл SEIS.DAT). 

Виконання вправи: геостатистичне моделювання поверхні по точках геофізич-

ного каротажу. ~ 25 хвилин.  

5. Коротко знайомство із географічною електронною енциклопедією - па-

кетом Amiglobe 2010: 1) загальний перегляд програмного забезпечення, 2) тест-

ігри на визначення: прапорів, столиць, форми кордонів країн ~ 20 хвилин.  

 

Лабораторне заняття 1.4 

1. Перевірка домашніх завдань № 3, 4. Студенти повинні завантажити 

власний файл  та виконати його в середовищі  MS Basic.  

2. Завантажити текст авторської програми й продемонструвати  роботу 

тільки файлу Добуток. Звернути увагу, що у теоретичному матеріалі щодо ДЗ 

№ 5 (дві задачі) ця програма записана дещо іншим чином.  

3.  Роздати студентам методичні матеріали для конспектування теоретич-

ного матеріалу щодо виконання домашнього завдання № 5 (Задача 1: Побуду-

вати  таблицю  відповідності  між  унціями  та грамами, якщо 1 унція = 

28,353495 г. Початкове значення кількості унцій (Un), крок зміни (Кг) цьо-

го значення та кількість рядків (N)  у таблиці задати самостійно в режимі 

діалогу; Задача 2: Протабулювати  дві функції  y=sinx, z= cosx на проміжку [0; 

1], змінюючи значення аргументу на 0,1.  Табулювання функції – це побудова 

таблиці значень функції для різних значень аргументу). Пп. 1-3 ~ 25   хвилин.  

4.  Самостійна робота (на оцінку) із підсистемою Аналіз Просторових Да-

них (файл SEIS.DAT) пакету Рельєф-Процесор. Моделювання поверхні по точ-

ках геофізичного каротажу ~ 15 хвилин. 

5.  Знайомство із підсистемою моделювання та аналізу флювіального ре-

льєфу пакету Рельєф-Процесор: моделювання мережі русел та вододілів ~ 25  

хвилин.  

6.  Знайомство із повноформатною геоінформаційною системою (ГІС) 

MapInfo Professional із допомогою мультимедійного підручника – студентам 

треба коротко переглянути (із поясненням викладача) перший урок - An Over-

view of MapІnfo Professional (Перегляд ГІС MapInfo) ~ 25 хвилин.  
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Лабораторне заняття 1.5 

1. Перевірити обидві задачі домашнього завдання № 5.  

2. Роздати студентам методичні матеріали щодо для запису тексту автор-

ських програм ДЗ № 5.   

3.  Задати домашні завдання 6 (використовуючи оператор циклу 

FOR.NEXT, складіть на алгоритмічній мові Бейсик програму підрахунку суми 

перших десяти цілих чисел і виведення результату підсумовування на друк) і 7 

(треба розглянути послідовність чисел, де перші два числа - це одиниці; кож-

не наступне число є сумою двох попередніх; такі числа називаються чи-

слами Фібоначчі; складіть програму на Basic, яка б  визначала десять 

наступних чисел послідовності). Коротко пояснити. Пп. 1-4 ~ 25   хвилин. 

4.  Робота із методичними матеріалами з програмування – файл Приклади 

1-1_1-3.pdf - алгоритми лінійної структури та тієї, що розгалужується: треба за-

писати дані по наданим прикладам, набрати в середовищі  MS QBasic тексти 

програм на цій алгоритмічній мові, перевірити їх роботу - приклади 1.2, 1.3; 

програми на шкільній алгоритмічній мові та на TurboPascal можна просто пере-

глянути; запропонувати студентами тут в аудиторії самостійно скласти на Бей-

сик програму із прикладу 1.1 ~ 30   хвилин.  

5.  Самостійна робота із підсистемою гідролого-геоморфологічного моде-

лювання цього пакету – (файли WFLOW.EXE, BlackRiver2.net) – моделювання 

русел та вододілів.  Поставити оцінку ~ 15  хвилин. 

6.  Продовження знайомства із повноформатною ГІС MapInfo Professional 

із допомогою мультимедійного підручника – переглянути по підручнику та в 

робочій версії MapInfo і повністю зробити другий (Mapping in Layers – Картог-

рафування в шарах) урок. ~ 20  хвилин. 

 

Лабораторне заняття 1.6 

1. Перевірка домашніх завдань № 6 та 7 – студенти повинні завантажити 

власні файли  та виконати їх в середовищі  MS QBasic.  

2.  Задати ДЗ № 8 (використовуючи оператор циклу FOR.NEXT, складіть 

на алгоритмічній мові Бейсик програму табулювання функції y= 3sin (x + 2,6) 

на проміжку [0; 1] з кроком h = 0,1. Знайти серед обчислених значень функції 

найбільше, та вказати аргумент, для якого це значення досягається) – це домаш-

нє завдання на використання оператору циклу FOR-NEXT вирішується за єди-

ним шаблоном, як і кілька попередніх. Пп. 1-3 ~ 20   хвилин. 
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3.  Коротко ще раз переглянути приклади і програми із методичних мате-

ріалів із програмування, що розглядалися на попередньому занятті ~ 10   хвилин. 

4.  Виконання завдання по роботі із програмним забезпеченням MS Office - 

Практикум із MS Word № 2 – Перевірити результати ~ 35   хвилин. 

5.  Продовження знайомства із повноформатною ГІС MapInfo Professional 

із допомогою мультимедійного підручника – переглянути по підручнику та в 

робочій версії MapInfo повністю повторно зробити другий (Mapping in Layers – 

Картографування в шарах карти) урок, законспектувати відповідні методичні 

матеріали ~ 25  хвилин. 

 

Лабораторне заняття 1.7 

1. Обговорення прийдешнього проміжного модульний контролю – тесту із 

MS QBasic.  

2. Перевірка домашнього завдання № 8.  

3.  Задати домашнє завдання № 9  (Задача 1: складіть на MS QBasic у 

файл *.BAS програму визначення кислотності розчину за допомогою лакмусово-

го папірця; використовуйте вже знайомі прості алгоритми лінійної структури, 

та такої, що розгалужується; нагадаємо, що якщо папірець забарвлюється у 

червоний колір - розчин кислотний, у синій колір - розчин лужний, не міняє ко-

льору - розчин нейтральний.  Задача 2: треба розробити алгоритм автомати-

чного визначення комп'ютером Вашої дати народження (мається на увазі, що 

дата народження може бути будь-якою, але у будь-якому випадку повинна 

правильно визначатися); обов'язкова умова: початковими даними має бути од-

но ціле число з його наступним обрахунком; використовуйте цикл типу ДЛЯ). 

Коротко пояснити. Запропонувати написати програмний  код за короткий про-

міжок часу. Пп. 1-3 ~ 20 хвилин. 

4. Закінчити Практикум із Word № 2. Викладачу перевірити результати, 

поставити оцінки  – 20   хвилин. 

5. Робота із методичними матеріалами з програмування – файл Приклади 

1.4-1.6_Task.pdf - алгоритми лінійної структури та тієї, що розгалужується (про-

довження) ~ 20   хвилин. 

6. Продовження знайомства із повноформатною ГІС MapInfo Professional 

із допомогою мультимедійного підручника – переглянути по підручнику та в 

робочій версії MapInfo зробити перший та другий уроки ~ 15  хвилин. 

7.  Початок роботи із ГІС-платформо ArcView 3.x – із мультимедійним пі-

дручником Getting to Know ArcView GIS (Учбовий посібник із ГІС АркВью). Об-
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рати на Робочому столі піктограму Getting to Know ArcView GIS =>ArcView GIS 

Tutorial = > File => Open Exercise+> ex7A =>Help=>Getting to Know ArcView 

GIS Contents = Chapter 7 Introducing ArcView GIS = > Exploring ArcView GIS 

=>Show Me (Вправа 7 - «Знайомство із АркВью»). Студентам треба переглянути 

мультимедійний файл із змістом вправи 7, ретельно законспектувати методичні 

вказівки із вправи – надається українською як .PDF файл  і виконати вправу са-

мостійно ~ 15 хвилин. 

 

Лабораторне заняття 1.8 

1. Проміжний модульний контроль – тест із АМ MS QBasic. Завдання по 

п’ятнадцяти  варіантах, які розподіляються по підгрупах за жеребом ~ 60 хвилин.  

2. Задати ДЗ № 10 (використовуючи оператор циклу WHILE, складіть на 

алгоритмічній мові Бейсик програму табулювання функції y= 3sin (X +2,6) на 

проміжку [0; п («пі»] з кроком h = 0,1; знайти середнє арифметичне значень 

функції більших, ніж 0,1 та менших ніж 0,6), коротко пояснити ~ 5 хвилин. 

3. Продовження роботи із системою гідролого-геоморфологічного моде-

лювання Рельєф-Процесор. Студентам треба самостійно змоделювати мережу 

русел та вододілів по басейну р. Чорна ~ 10  хвилин. 

4.  Продовження роботи із ГІС-платформо ArcView 3.x – із мультимедій-

ним підручником Getting to Know ArcView GIS (Учбовий посібник із ГІС Арк-

Вью). Обрати на Робочому столі  Getting to Know ArcView GIS => ArcView GIS 

Tutorial = > File => Open Exercise+> ex8А >Help=>Show Me Ex 8A (Вправа 8А 

– Додавання шарів до Вікна перегляду) – Adding Themes To View. Треба перегля-

нути мультимедійний файл із змістом вправи 8А, законспектувати методичні 

матеріали із вправи і виконати вправу самостійно ~ 15  хвилин. 

 

Лабораторне заняття 1.9 

1. Обговорення результатів проміжного модульного контролю – тесту із  

MS QBasic  ~ 10 хвилин. 

2.  Перевірка домашнього завдання № 10, із коротким поясненням ~ 15 

хвилин. 

3. Задати домашнє завдання № 11 (є координати (x1; y1), (x2; y2), (x3; y3) 

трьох вершин трикутника у площині; обчислити медіану mb  та радіус  описано-

го кола r; треба написати програму на Бейсик для трикутника з координатами 

вершин (1; 1), (2; 2), (-1; 2), які треба ввести за допомогою команди READ та 

блоку даних); коротко пояснити ~ 5 хвилин. 



 29 

4.  Продовження роботи із файлом Приклади 1.4-1.6_Task.pdf : треба конс-

пектувати дані по прикладам, набрати в середовищі  MS QBasic тексти програм 

на цій алгоритмічній мові, перевірити їх роботу ~ 15   хвилин. 

8. Робота із Переглядачем ГІС-карт ArcExplorer – уроки 2 «Що це?» та 3 

«Де це?» - роздруковані методичні матеріали (англійською та українською) на-

даються, ці матеріали повторюють зміст PDF файлу Lessons_2_3_Arc_Explorer  

~ 30   хвилин.  

9.  Продовження роботи із ГІС-платформо ArcView 3.x – із мультимедій-

ним підручником Getting to Know ArcView GIS (Учбовий посібник із ГІС Арк-

Вью). Обрати на Робочому столі  Getting to Know ArcView GIS =>ArcView GIS 

Tutorial = > File => Open Exercise+> ex8B =>Help=> Open Data Ex 8A – Дода-

вання шарів до Вікна перегляду – Adding Themes To View. Виконати вправу само-

стійно, без допомоги програми Help ~ 15  хвилин. 

 

Лабораторне заняття 1.10 

1. Перевірити домашнє завдання № 11, коротко пояснити (вказати на мо-

жливість використання замість оператору READ оператору INPUT) ~ 20 хвилин.  

2. Оголосити про необхідність підготовка до вихідного модульного конт-

рою (ВМК) - заліку. 

3.  Закінчення роботи із файлом Приклади 1.4-1.6_Task.pdf : треба конспе-

ктувати дані по прикладам, набрати в середовищі  MS QBasic тексти програм на 

цій алгоритмічній мові, перевірити їх роботу ~ 10   хвилин. 

4. Робота із завданням щодо офісного додатку MS Excel  – рішення прос-

тих розрахункових завдань. Роздруковані  методичні матеріали надаються ~ 40 

хвилин. 

5. Продовження знайомства із ГІС-платформою MapInfo – третій урок – 

Геокодування (Putting your data on the Map). Треба використовувати мультимед-

йний підручник MapInfo Tutorial і відповідні дані ~ 15  хвилин. 

 

Лабораторне заняття 1.11 

1.  Вихідний модульний контроль із курсу (залік) по чотирнадцяти варіан-

тах завдань ~ 90 хвилин 
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Другий семестр вивчення курсу  

(закінчення другого, третій та четвертий модулі)  

 

Лабораторне заняття 2.1 

1. Заняття на повторення пакету Рельєф - Процесор. Необхідно послідовно 

перевірити як студенти пам'ятають: 1) роботу з підсистемою Аналіз Просторо-

вих Даних – робочий файл SEIS.DAT, 2) побудову мережі долин-вододілів і мор-

фометричний аналіз рельєфу – робочий файл BLACKRV2.NET ~ 25 хвилин.  

2. Повторення та засвоєння нового матеріалу – робота із ГІС MapInfo Pro-

fessional: студентам треба виконати із допомогою мультимедійного підручника 

MapInfo Tutorial:  третій урок Putting Your Data on the Map (Геокодування); чет-

вертий урок Selecting (Процедури Вибору) та п’ятий урок Drawing and Editing 

(Креслення та Редагування). Треба законспектувати відповідні методичні мате-

ріали ~ 40 хвилин.  

3. Робота  із мультимедійним підручником ГІС-платформи ArcView 3.x: із  

Розділами 8 та 9 – залучення даних до ArcView3.X, візуалізація та класифікація 

шарів Вікна Карти: треба виконати вправи 8B – Розуміння таблиць шарів (Un-

derstanding Theme Tables) та 9A – Класифікація об’єктів на підставі їхніх атри-

бутів (Classifying Features Basing on Their Attributes) із конспектуванням відпо-

відних методичних матеріалів ~  25 хвилин. 

 

Лабораторне заняття 2.2 

1. Почати виконання Практикуму по MS Word № 3 ~ 25 хвилин.   

2. Засвоєння нового матеріалу – знайомство із реляційною системою ке-

рування базами даних (СКБД) корпорації Microsoft MS Access. Короткий огляд 

широкого спектру функцій, включаючи пов'язані запити, зв'язок із зовнішніми 

таблицями і базами даних. Треба звернути увагу студентів, що завдяки вбудова-

ній мові VBA, в самому MS Access можна писати додатки-застосування, пра-

цюючі з базами даних. Почати виконання Практикуму по MS Access № 1~ 30 

хвилин.   

3. Закінчення засвоєння нового матеріалу із ГІС – робота із ГІС MapInfo 

Professional:  четвертий урок Selecting (Процедури Вибору) та п’ятий урок Draw-

ing and Editing (Креслення та Редагування) ~ 15 хвилин.  

4.  Робота  із мультимедійним підручником ГІС-платформи ArcView 3.x: із  

Розділом 9 -  візуалізація та класифікація шарів Вікна Карти: обрати на Робочо-

му столі  Getting to Know ArcView GIS =>ArcView GIS Tutorial = > File => Open 
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Exercise+> ex9В =>Help=>Show Me Ex 9В (Редагування Легенд); обрати на Ро-

бочому столі  Getting to Know ArcView GIS =>ArcView GIS Tutorial = > File => 

Open Exercise+> ex9С =>Help=>Show Me Ex 9С (Використання різних класифі-

кацій); обов’язково законспектувати методичні матеріали (українською) із обох 

вправ ~ 25 хвилин. 

5. Задати домашнє завдання №  12: (розробити  на АМ MS QBasic програ-

му, що виконує  знаходження максимального значення радіусу нижньої основи 

усіченого  прямого конуса R2 (що змінюється від L до N з кроком M)  і  таке, 

яке відповідає значенню висоти H2 і твірної O прямого конуса, для яких об'єм 

усіченого прямого конуса не перевищує об'єм прямокутного паралелепіпеда із 

сторонами A,B,C.  Радіус верхньої підстави R1 і висота Н1 усіченого  прямого  

конуса залишаються незмінними). Коротко пояснити  ~ 5 хвилин. 

 

Лабораторне заняття 2.3 

1. Перевірка домашнього завдання № 12.Студенти завантажують власні 

рішення. Потім їм надається авторське рішення викладача для набору в файл ~ 

15 хвилин. 

2.  Задати та коротко пояснити домашнє завдання № 13 – серія прості про-

грами - лінійний алгоритм, що реалізується через АМ MS QBasic. Студентам 

треба законспектувати теоретичну частину із цього завдання  (Задача 1: Відс-

тань до найближчої до Землі зірки Альфа Центавра 4,3 світлових роки Швид-

кість світла прийняти 300 000 км/с. Швидкість земного зорельота 100 км/с. За 

скільки звичайних (земних) років зореліт досягне цієї зірки? Задача 2: Дискета 

3,5" вміщає 1,44 Мбайт. Рукопис містить 450 сторінок тексту. На кожній сторін-

ці 60 рядків по 80 символів в кожній. Чи поміститься рукопис на дискету? Якщо 

ні, то скільки таких дискет знадобиться?) ~ 15 хвилин. 

3. Закінчити виконання Практикуму № 3 із Word - перевірити, поставити 

оцінки ~ 25 хвилин.  

4.  Закінчити виконання Практикуму № 1 із MS Access  - перевірити, пос-

тавити оцінки ~ 15 хвилин. 

5.  Cамостійна робота (на оцінку) із пакетом гідролого-геоморфологічного 

моделювання Рельєф-Процесор – 1) моделювання зон забруднення; 2) моделю-

вання морфолого-морфометричних характеристик водозбору ~ 20 хвилин.    
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Лабораторне заняття 2.4 

1. Перевірка та додаткове пояснення обох задач домашнього завдання № 

13  ~ 10  хвилин. 

2. Викладач має задати та коротко пояснити домашнє завдання № 14 (нове 

завдання на побудову лінійного алгоритму: продавши квартиру, ви отримали $ 

22 000 і поклали їх (під %) у банк; банк нараховує 1% в перший місяць, а кожен 

наступний — теж 1%, але вже з суми, що вийшла; скільки грошей буде у банку 

на вашому рахунку через рік? (нестабільністю нашої економічної системи нех-

туємо) ~ 10 хвилин. 

3. Студентам закінчити виконання Практичної роботи № 3 із Word, ви-

кладачу - перевірити, поставити оцінки ~ 15 хвилин.  

4. Робота із базовими програмами операційної системи – групою Станда-

ртні: робота із графічним редактор Paint; розповсюджуються надруковані ме-

тодичні матеріали ~ 50 хвилин.    

5. Робота  із мультимедійним підручником ГІС-платформи ArcView 3.x: із  

Розділом 10 – Символізація Тем: обрати на Робочому столі  Getting to Know 

ArcView GIS =>ArcView GIS Tutorial = > File => Open Exercise+> ex10A 

=>Help=>Show Me Ex10A (Використання маркерів та градуйованих символів); 

обов’язково законспектувати методичні матеріали (українською) із вправи, які 

надаються ~ 15 хвилин. 

 

Лабораторне заняття 2.5 

1. Перевірка та додаткове пояснення ДЗ № 14  ~ 10 хвилин. 

2. Задати та пояснити домашнє завдання № 15 (на виконання команди 

умовного переходу в MS QBasic: задача № 1: обчислити і вивести значення 

складеної функції у в деякій заданій користувачем точці х, якщо виконується 

певна умова; задача № 2: написати програму, згідно якої треба увести з клавіа-

тури ціле число; поки не введено 0 роботу продовжувати; додатне число вивес-

ти на екран, в протилежному випадку вивести повідомлення "ВІД'ЄМНЕ ЧИС-

ЛО"; програма має надавати можливість вводити та аналізувати декілька чисел, 

доки не буде введено число 0 - ознака закінчення роботи програми);  студенти 

мають законспектувати теоретичний матеріал та зміст домашнього завдання = 

15 хвилин. 

3. Задати та коротко пояснити перше домашнє завдання із арифметичних 

основ інформаційних технологій - АОІТ (1А) ~ 5 хвилин  
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4. Робота із методичними матеріалами із програмування – Приклади 2.3-

2.5_Task.pdf: реалізація алгоритмів типу «для»  ~ 15 хвилин. 

5. Практикум № 4 із MS Word: Формули, індекси, спеціальні символи; ме-

тодичні матеріали надаються ~ 30 хвилин. 

6. Викладачу продемонструвати студентам моделювання оптимального 

розташування водосховища  в пакеті Рельєф–Процесор ~ 15 хвилин. 

 

Лабораторне заняття 2.6 

1. Перевірка із додатковим поясненням ДЗ № 15 ~ 15 хвилин. 

2.  Перевірка ДЗ № 1А (із АОІТ), треба коротко опитати кожного студента   

~ 10 хвилин. 

3.  Викладачу задати та коротко пояснити домашнє завдання № 16 (за до-

помогою засобів графіки АМ MS QBasic треба намалювати літаючу тарілку (ілюстрація нада-

ється)), розповсюдити методичні матеріали Графічні конструкції через АМ MS 

QBasic ~ 5 хвилин. 

4.  Студентам закінчити роботу із методичними матеріалами з програму-

вання – Приклади 2.3-2.5_Task.pdf: реалізація алгоритмів типу «для»  ~ 20 хви-

лин. 

5. Студентам закінчити роботу із Практикум № 4 із MS Word: Формули, 

індекси, спеціальні символи;отримати оцінки; методичні матеріали надаються ~ 

15 хвилин. 

6. Перше знайомство із візуальним програмуванням: основні поняття, ін-

струменти середовища АМ Visual Basic , палітра компонентів, вікно властивос-

тей об’єктів ~ 25 хвилин. 

 

Лабораторне заняття 2.7 

1. Перевірити, розглянути та додатково пояснити домашнє завдання на 

графічні побудови через АМ Бейсик - № 16. Продемонструвати власне рішення. 

Файл додається. Роздати власне рішення для набору – роздруківки додаються ~ 

15 хвилин.  

2. Задати та коротко пояснити домашнє завдання № 17: робота операторів 

DATA та READ (напишіть на MS QBasic програму, яка малює три закрашені 

прямокутники із заданими координатами діагоналей і кольорами) ~ 5 хвилин. 

3. Задати та коротко пояснити домашнє завдання № 2A, із АОІТ  ~ 5 хви-

лин.  
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4. Студентам почати виконувати Практичну роботу № 1 із VisualBasic: 

програмування кнопок; об’єкти: форма, текстове поле, зображення, кнопка ~ 

20 хвилин. 

5. Студентам знову швидко виконати на оцінку самостійно завдання 

по роботі із системою гідролого-геоморфологічного моделювання Рельєф-

Процесор: 1) моделювання просторового забруднення; 2) моделювання оптима-

льного розташування водосховища ~ 20 хвилин 

6. Продовження знайомства із засобами ГІС – початок роботи із пакетом 

моделювання геостатистичного та інтерполяційного моделювання Vertical 

Mapper – знайомство з графічним інтерфейсом користувача; роздруковані мето-

дичні матеріали надаються, студентам треба законспектувати теоретичний ма-

теріал із просторової інтерполяції ~ 25 хвилин. 

 

Лабораторне заняття 2.8 

1. Перевірити та додатково пояснити домашнє завдання на графічні побу-

дови через АМ MS QBasic - № 16. Продемонструвати авторське рішення ~ 10 

хвилин. 

2. Задати та коротко пояснити домашнє завдання № 18, нове завдання із 

графічних побудов через алгоритмічну мову MS QBasic (Напишіть програму, 

яка виводить на екран петлю гістерезису, остання складається з двох відрізків 

прямих ліній і чотирьох дуг, що є чвертями кола. Спробуйте спочатку намалю-

вати зображення в масштабі на папері, розрахувати усі початкові дані. Зафар-

буйте зображення, що вийшло. (Будьте уважні при стикуванні дуг, частенько 

там утворюються розриви) ~ 5 хвилин   

3. Перевірити домашнє завдання № 2A із арифметики, опитати кожного    

~ 10  хвилин  

4.  Задати та коротко пояснити домашнє завдання № 3A із арифметики ~ 5 

хвилин. 

5.  Студентам закінчити виконувати Практичну роботу № 1 із VisualBasic 

(створити форму “Анкета студента” з даними про себе і двома фотографія-

ми (портретною і художньою), які перекривають одна одну і мають 

з’являтися в результаті натискання на кнопки) ~ 45 хвилин. 

6.  Закінчення роботи із першим завдання щодо пакету геостатистичного 

моделювання Vertical Mapper ~ 15 хвилин. 
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Лабораторне заняття 2.9 

1. Проміжний модульний контроль із АМ MSQBasic: студенти мають на-

бирати в файл програми із коментарями ~ 60 хвилин  

2. Проміжний модульний контроль по роботі із ГІС-засобами: 1) ГІС-

платформою MapInfo Professional; 2) системою гідролого-геоморфологічного 

моделювання Рельєф-Процесор ~ 30 хвилин. 

 

Лабораторне заняття 2.10 

1. Викладачу ознайомити студентів із результатами проміжного модуль-

ного контрою та обговорити їх ~ 5 хвилин.   

2. Перевірити та додатково пояснити домашнє завдання на графічні побу-

дови через АМ MS QBasic № 16 ~ 10 хвилин. 

3. Задати та коротко пояснити домашнє завдання № 19, нове завдання із 

графічних побудов через алгоритмічну мову MS QBasic (напишіть програму, що 

малює ланцюжок дотичних кіл із заданими в операторі DATA радіусами (малю-

нок надається) ~ 5 хвилин.  

4. Викладачу перевірити домашнє завдання № 3A із АОІТ, опитати кож-

ного студента на оцінку ~ 20 хвилин  

5. Робота із методичними матріалами з програмування - Приклади 3.1-

3.2_Task.pdf: реалізація вкладених алгоритмів типу «для»; набрати текст про-

грами в файл, переписати всі дані та накреслити блок-схеми у зошит ~ 25 хвилин 

6. Студентам почати виконувати Практичну роботу № 2 із VisualBasic 

(створити форму з назвою обмін валюти, на якій можна змоделювати операції 

обміну валюти у обмінному пункті) ~ 25 хвилин. 

 

Лабораторне заняття 2.11 

1. Викладачу перевірити, розглянути та пояснити домашнє завдання на 

графічні побудови через АМ MS QBasic - № 19. Продемонструвати  авторське 

рішення та розповсюдити серед студентів методичні матеріали щодо цього рі-

шення ~ 20 хвилин.  

2.  Задати та пояснити домашнє завдання № 20 із MS QBasic – тема Вико-

ристання одновимірних масивів (введення-виведення масивів) (Треба утворити 

масив у,  елементи якого обчислюються за формулою yk = lnk-5, де k = 1,2,…, 

15. Побудувати масив  g, який складається з від’ємних елементів масиву y. Ви-

вести повідомлення у разі відсутності шуканих величин).  Термін – один тиж-

день  ~ 5 хвилин. 
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3.  Задати домашнє завдання № 4A із АОІТ, коротко пояснити ~ 5 хвилин. 

4.  Виконання Практикуму № 1 із мови HTML та Web-дизайну. Методичні 

матеріали будуть надані, електронні початкові файли розмістити на мережному 

диску  ~ 60 хвилин. 

 

Лабораторне заняття 2.12 

1. Перевірити, розглянути та додатково пояснити домашнє завдання на  

Використання одновимірних масивів (введення-виведення масивів) через АМ 

Бейсик - № 20. Продемонструвати  рішення викладача ~ 20 хвилин. 

2.  Задати та пояснити ДЗ № 21 – наступне із програмування  на АМ MS 

QBasic (Побудувати  таблицю  відповідності  між  унціями  та рамами, якщо 1 

унція = 28,353495 г. Початкове значення кількості унцій (Un), крок зміни 

(Кг) цього значення та кількість рядків (N)  у таблиці задати самостійно в 

режимі діалогу); теоретичну частину завдання – приклад опису циклів – студе-

нтам треба законспектувати вдома ~ 10 хвилин. 

3. Перевірити домашнє завдання № 4A, опитати кожного ~ 15 хвилин.  

4. Колоквіум із теоретичного матеріалу – питання заздалегідь розповсю-

джуються серед студентів; викладачу опитати, поставити відмітку кожному ~ 50 

хвилин. 

Питання до колоквіуму: 

1. Загальні поняття про архітектуру та структуру комп’ютерів; 

2. Принципи сучасної архітектури комп’ютерів; 

3. Класифікація комп’ютерів; 

- за призначенням; 

- по рівню спеціалізації; 

- за розміром та сумісністю.  

4.  Загальна будова комп’ютерів як базова апаратна конфігурація; 

5.  Базові команди та їхнє виконання. 

6. Файли як одиниці зберігання даних і файлові структури. 

7. Операції з даними. 

8. Основні структури даних: 

- лінійні структури даних 

- табличні структури даних (таблиці даних, матриці даних) 

- ієрархічні структури даних 

- впорядкування структур даних 

9.   Файлова система 
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10. Введення в алгоритмічну мову Бейсик. 

11. Основні системні команди, алфавіт та конструкції мови Бейсик. 

12. Структурна організація алгоритмів.  

13. Середовище програмування АМ Бейсик. 

14. Загальні поняття про системи числення. Принципи двоічної та десятичної систем 

числення. 

15. Які системи числення використовують ІТ?  

16. Деякі арифметичні операції в позиційних ситемах численя.  

17. Сучасний географічний підхід к дослідженню природно-антропогенного довкіл-

ля – методологія геоінформаційних систем (ГІС). 

18. Що таке геоінформаційна система? Особливості досліджень на підставі ГІС-

аналізу. 

19. Математичний апарат в середовищі ГІС (на прикладі топології і графічних при-

мітивів). 

20. ГІС для предметних та регіональних проектів.  

 

Лабораторне заняття 2.13 

1. Обговорення результатів колоквіуму, розповсюдження оцінок ~ 10 

хвилин.  

2. Перевірити та додатково пояснити ДЗ № 19 ~ 15 хвилин.  

3. Задати ДЗ № 22 на приклад опису циклів (скласти на АМ MS QBasic 

програму-словник, яка у відповідь на введена англійське слово виводить його 

український переклад. Переклад можна виводити «транслітом». Англійські 

слова та їх українські відповідники розмістити попарно в блоці даних). 

4. Задати ДЗ № 5А – наступне із АОІТ, коротко пояснити ~ 5 хвилин. 

5. Задати студентам завдання: принести наступного разу графічні файли 

будь-яких карт із відомими точками координат для виконання в ГІС MapInfo 

Professional растрової прив’язки – реєстрації зображення, пояснити особливості 

цього завдання ~ 5 хвилин. 

6. Робота в програмному середовищі офісного додаткуMS Excel - робота 

із електронними таблицями – розв’язання задачі про облік продукції через MS 

Excel ~ 30 хвилин.  

7. Продовження знайомства із Переглядачем ГІС-карт ArcExplorer  – До-

слідження 5 (На що це схоже?) та Дослідження 6 (Де це? Частина друга)  ~ 25 

хвилин 
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Лабораторне заняття 2.14 

1. Перевірити та додатково пояснити ДЗ № 20 – створення словника ~ 10 

хвилин.  

2. Перевірити ДЗ № 5А – опитати кожного ~ 15 хвилин. 

3. Задати ДЗ № 21 щодо складення програми для пошуку інформації за 

допомогою АМ  MS QBasic (1) cтворити (наприклад у Блокноті) файл із списком 

річок та величиною їхніх басейнів; 2) скласти на  QBasic програму для читання 

(введення) у масив з іменем А$ (в оперативну пам'ять) даних з файлу RIKY.DAT ; 

вивести на екран назви річок, довжина яких більша 5500 км), коротко пояснити 

~ 10 хвилин. 

4.  Робота із графічними файлами будь-яких карт із відомими точками ко-

ординат для виконання в ГІС MapInfo Professional растрової прив’язки – реєст-

рації зображення ~ 30 хвилин. 

5. Початок роботи по проектуванню і заповненню бази даними - робота із 

програмами класу СКБД dBase, FoxBase тощо (Завдання 1. Створіть базу даних 

про своїх друзів з такою структурою: прізвище, ім’я, дата народження, зріст, 

номер телефону. Завдання 2. Створіть базу даних про облік деяких товарів у 

магазині чи на складі з такими полями: номер, назва, кількість, ціна) ~ 25 хви-

лин. 

 

Лабораторне заняття 2.15 

1. Семестрова контрольна робота із арифметичних основ інформаційних 

технологій за чотирнадцятьма варіантами ~ 50 хвилин.  

2. Перевірити та додатково пояснити ДЗ № 21 – пошук інформації через 

засоби MS QBasic ~ 10 хвилин.  

3. Задати перше домашня завдання із логічних основ інформаційних тех-

нологій (ЛОІТ) - № 1Л, пояснити ~ 10 хвилин.  

4. Продовження роботи по проектуванню і заповненню бази даними - ро-

бота із програмами класу СКБД dBase, FoxBase ~ 20 хвилин.  

 

Лабораторне заняття 2.16 

1. Коротко обговорити із студентами результати семестрової роботи з АО-

ІТ ~ 10 хвилин.  

2. Перевірити домашнє завдання – із ЛОІТ № 1Л – опитати кожного = 15 

хвилин 

3. Задати ДЗ № 2Л із ЛОІТ, коротко пояснити ~ 5 хвилин. 
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4. Задати ДЗ № 22, чергове завдання із програмування на MS QBasic   – 

рішення на «метод бульбашки», коротко пояснити за текстом задачі (Завдання: 

Напишіть програму, що реалізовує метод "бульбашки". Для зменшення кількос-

ті непотрібних порівнянь може служити лічильник, що підраховує кількість об-

мінів за один повний пробіг уздовж усього масиву. Як тільки його значення до-

рівнюватиме нулю (т. е. жодного нового обміну не буде здійснено), це означа-

тиме, що масив впорядкований. Для наочності оформите початковий масив, що 

вийшов, у вигляді стовпчикових інтерпретацій один під одним) ~ 15 хвилин.  

5. Практична робота по створенню презентацій в MS Power Point на геог-

рафічну тематику, зміст презентації наповнювати на підставі власних знань, 

для цього також можна використовувати будь-яке програмне забезпечення, яке 

є на комп’ютері. Перевірити, поставити оцінки. Роздруковані методичні вказів-

ки із MS Power Point надаються ~ 45 хвилин.  

 

Лабораторне заняття 2.17 

1. Перевірити домашнє завдання – із ЛОІТ № 2Л – опитати кожне ~ 15 

хвилин. 

2. Перевірити ДЗ № 22 – ―метод бульбашки‖ ~ 10 хвилин. 

3. Практична робота в середовищі візуального програмування Visual Basic 

(створити програму, яка працюватиме з базою даних  - адресною (записною) 

книжкою, сформованою у вигляді файлу записів) ~ 40 хвилин.  

4.  Виконання у Переглядачі ГІС-карт ArcExplorer проекту «Подорож до 

Ріо», відкрити початковий проект Rio.AEP в теці Explorer та виконати його; ме-

тодичні матеріали надаються ~ 25 хвилин. 

 

Лабораторне заняття 2.18 

1. Підсумковий модульний контроль (іспит) по п’ятнадцяти варіантах за-

вдань = 90 хвилин 
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ПРИКЛАДИ ЗАВДАНЬ ВИХІДНОГО МОДУЛЬНОГО                                   

КОНТРОЛЮ (ЗАЛІКУ)  

 

ВАРІАНТ № 1. Час виконання – 90 хвилин 

 

1.1.-1.2.  Складіть програми на АМ  MS QBasic, та запишіть, зберігаючи у файлі в  

робочій теці, яку Ви оберете.  
Покажіть викладачу консольний режим результату виконання програми! 

Запишіть імена файлу проти свого П.І.Б. в Таблицю Обліку таким чином:  

Наприклад, Ви народилися 1-го січня 1993 року, тоді Ваш файл 1-ї задачі називатиметься 010113.BAS, файл 2-ї 

задачі  -  010123.BAS. Для програми також запишіть час її збереження на жорсткий гвинт!     

Проконтролюйте, щоб викладач записав Вашу  програму собі на магнітний носій  для перевірки: 

П.І.Б.  

 

Ім'я файлу 1-ї задачі на MS 

QBasic 

 

 

Ім'я файлу 2-ї задачі на MS 

QBasic 

 

 

Напишіть просту програму на будь-якій алгоритмічній мові із сімейства Basic – 

Basic, QuickBasic, Turbo Basic  для визначення сторони (С), периметра (Р) та 

площі (S) трикутника за відомими катетами: А=5; В=3,6. Можна (і навіть – 

треба) використовувати ваші власні дані. Критерій оцінки – програма повинна працювати! 

 

Напишіть на алгоритмічній мові із використанням оператору умовного перехо-

ду IF… THEN (Якщо… тоді) програму, яка виводить на екран повідомлення про 

вірне або невірне значення добутку «2*2=» як результат вводу цього числа із 

клавіатури.  

 

1.3.  Відповідайте письмово на питання:  Що таке інформатика та інформа-

ція? Поняття галузевої і прикладної інформатики. Початкові уявлення про гео-

інформатику. 

 

1.4. Виконайте в пакеті гідролого-геоморфологічного моделювання Рельєф-

Процесор обробку файлу з даними геофізичного каротажу по двох файлах – 

Seis.DAT, POLN_C.DAT – і отримання з них відповідних файлів *.NET.  Результат 

покажіть викладачу! 

 

1.5. Відповідайте письмово на питання: Вступ до алгоритмічної мови. Основні 

системні команди, алфавіт і конструкції алгоритмічної мови Бейсик. 
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ВАРІАНТ № 7. Час виконання – 90 хвилин 

 

7.1.- 7.2. Складіть програми на АМ MS QBasic, та запишіть, зберігаючи у файлі 

в робочій теці, яку оберете  
Покажіть викладачу консольний режим результату виконання програми! 

Запишіть імена файлу проти свого П.І.Б. в Таблицю Обліку таким чином: 

Наприклад, Ви народилися 1-го січня 1993 року, тоді Ваш файл 1-ї задачі називатиметься 010113.BAS, файл 2-ї 

задачі  -  010123.BAS. Для програми також запишіть час її збереження на жорсткий гвинт!     

Проконтролюйте, щоб викладач записав обидві Ваші  програми собі на магнітний носій для перевірки: 

П.І.Б.  

 

Ім'я файлу 1-ї задачі на MS 

QBasic 

 

Ім'я файлу 2-ї задачі наMS 

QBasic 

 

 

Напишіть у файл на MS QBasic текст програми, яка визначає, яка з точок ближ-

ча до початку координат, тобто виконаєте рішення наступної задачі:  Дано три 

точки на площині. Визначити, яка з них ближча до початку координат.  

Критерій оцінки – програма повинна працювати!. 

 

Протабулювати  дві функції 

y=sinx, z= cosx 

на проміжку [0; 1], змінюючи значення аргументу на 0,1. Нагадаємо, що  табу-

лювання функції – це побудова таблиці значень функції для різних значень ар-

гументу. Напишіть у файл на MS QBasic текст програми. 

 

7.3.  Відповідайте письмово на питання: Відеокарта комп’ютера. 

 

7.4. Виконайте вправи у переглядачі ГІС-карт ArcExplorer по проекту міста Ва-

шінгтон (DC.aep), які дають відповідь на питанні Де це? Що це? Результат покажіть 

викладачу! 

  

7.5.  Відповідайте письмово на питання: Розвиток засобів кодування в 

комп’ютерній техніці.  
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ВАРІАНТ № 14. Час виконання – 90 хвилин 

 

14.1.- 14.2.  Складіть програми на АМ MS QBasic, та запишіть зберігаючи у 

файлі в робочій теці, яку Ви оберете.  
Покажіть викладачу консольний режим результату виконання програми! 

Запишіть імена файлу проти свого П.І.Б. в Таблицю Обліку таким чином: 

Наприклад, Ви народилися 1-го січня 1993 року, тоді Ваш файл 1-ї задачі називатиметься 010112.BAS, файл 2-ї 

задачі  -  010123.BAS. Для програми також запишіть час її збереження на жорсткий гвинт!     
Проконтролюйте, щоб викладач записав обидві Ваші  програми собі на дискету для перевірки: 

П.І.Б.  

Ім'я файлу 1-ї задачі на MS 

QBasic 
 

Ім'я файлу 2-ї задачі на MS 

QBasic 
  

   

Складіть на АМ MS QBasic програму і запишіть її у файл, програма має обчис-

лювати добуток чисел від 1 до 8. Позначте поточне значення числа N, а добуток 

- D. Критерій оцінки – програма повинна працювати! 

 

Напишіть на алгоритмічній мові із використанням оператору умовного перехо-

ду IF… THEN (Якщо… тоді) програму, яка виводить на екран повідомлення 

про вірне або невірне значення добутку «2*2=» як результат вводу цього числа 

із клавіатури. 

 

14.3. Відповідайте письмово на питання: Історія засобів передачі термінових 

 повідомлень. 

 

14.4. Виконайте без допомоги мультимедійного підручника із ГІС MapInfo  

вправу Картографування в шарах – Mapping in Layers. Результат покажіть викладачу! 

 

14.5.  Відповідайте письмово на питання:  Інформатика і інформація – базові 

поняття.   
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ПРИКЛАДИ ЗАВДАНЬ ПІДСУМКОВОГО МОДУЛЬНОГО                                   

КОНТРОЛЮ (ІСПИТУ) 

 

ВАРІАНТ № 3. Час виконання – 90 хвилин 

 

3.1. Треба розробити програму, яка вітає користувача після введення його ім’я. 

Складіть на MS QBasic у файл *.BAS відповідну програму. Критерій оцінки – програма 

повинна працювати!   

 

3.2. Напишіть на АМ MS QBasic програму, що реалізовує метод "бульбашки". 

Для зменшення кількості непотрібних порівнянь може служити лічильник, що 

підраховує кількість обмінів за один повний пробіг уздовж усього масиву. Як 

тільки його значення дорівнюватиме нулю (т. е. жодного нового обміну не буде 

здійснено), це означатиме, що масив впорядкований. Для наочності оформите 

початковий масив, що вийшов, у вигляді стовпчикових інтерпретацій один під 

одним. Критерій оцінки – програма повинна працювати!   

 

3.3. Робота в середовищі візуального програмування Visual Basic: створіть фор-

му Анкета студента. Критерій оцінки – програма повинна працювати!   

 

3.4.  Відповідайте письмово на питання: Що таке «алгебра логіки»? Основні 

операції – логічні зв’язки, коротко охарактеризуйте кожну.   

 

3.5.  Продемонструйте  головні навички роботи із пакетом геостатистичного 

моделювання Vertical Mapper – відкрийте та порівняйте числовий та класифіка-

ційний «грід»-файли, застосуйте Infotool пакету  Vertical Mapper; побудуйте по-

верхню ―грід‖ із точкового файлу MapInfo (файл ―MiniMap.tab‖ из директории 

VM\Tutorial\Lesson01). Результат покажіть викладачу! 

 

3.6.  Відповідайте письмово на питання: Загальна будова комп’ютерів як  базо-

ва апаратна конфігурація. Будь-ласка, не відповідайте на це питання лише об-

межуючись переліченням «залізних складових» комп’ютеру. 

 

3.7. Завдання на знання логічних основ інформаційних технологій: складіть 

ряд складних правдивих та хибних висловлювань; запишіть складні висловлення 

формалізованим чином.  
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ВАРІАНТ № 9. Час виконання – 90 хвилин 

 

9.1. Складіть на АМ MS QBasic у файл *.BAS програму, згідно якої треба увести 

з клавіатури ціле число. Поки не введено 0 роботу продовжувати. Додатне чис-

ло вивести на екран, в протилеж¬ному випадку вивести повідомлення "ВІД'Є-

МНЕ ЧИСЛО". Програма має надавати можливість вводити та аналізувати декі-

лька чисел, доки не буде введено число 0 - ознака закінчення роботи програми.   

Напишіть програму на АМ MS QBasic. Критерій оцінки – програма повинна працювати! 

 

9.2.  Складіть на АМ QuickBasic у файл програму для вирішення лінійних сис-

тем в загальному вигляді,  передбачивши введення коефіцієнтів за допомогою 

оператора INPUT. Запустіть програму на виконання. Критерій оцінки: програма повинна 

працювати! 

 

9.3. Робота в середовищі візуального програмування Visual Basic: створіть фор-

му із назвою Обмін валюти в обмінному пункті. Треба застосовувати поля реда-

гування (TextBox), та перемикачі (Option-Button), а також кнопки для виконан-

ня обчислень та закінчення роботи програми. Критерій оцінки – програма повинна працю-

вати 

 

9.4. Відповідайте письмово на питання Файли як одиниці зберігання даних і 

файлові структури. 

 

9.5.  Виконайте прив’язку растрового зображення топографічної карти через 

ГІС-платформу MapInfo Professional. Дані розташовані в теці  \Isput 

2011\РАСТР. Результат покажіть викладачу! 

 

9.6.  Відповідайте письмово на питання: Кодування символьної інформації. 

 

9.7.  Завдання для роботи в програмному середовищі офісного додатку MS Excel 

- робота із електронними таблицями – треба розв’язати задачу про облік проду-

кції через MS Excel. 
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ВАРІАНТ № 15. Час виконання – 90 хвилин 

 

15.1.  Треба побудувати  таблицю  відповідності  між  унціями  та грамами, як-

що 1 унція = 28,353495 г. Початкове значення кількості унцій (Un), крок зміни 

(Кз) цього значення та кількість рядків (N)  у таблиці задати самостійно в режи-

мі діалогу. Напишіть програму на MS QBasic. Критерій оцінки – програма повинна працю-

вати! 

 

15.2. Використовуючи оператор циклу FOR.NEXT, складіть на алгоритмічній 

мові MS QBasic програму підрахунку суми перших десяти цілих чисел і виве-

дення результату підсумовування на друк. Критерій оцінки – програма повинна працювати! 

 

15.3. Робота в середовищі візуального програмування Visual Basic: Створити 

форму для розв'язування задачі табулювання функції. Побудувати у ній головне 

меню з командами: закінчити роботу програми, табулювати функцію, очистити 

поля виведення результатів. Результати табулювання вивести у багаторядкове 

поле редагування (об'єкт типу Text). Передбачити можливість виведення ре-

зультатів на екран, у файл, у масив. Напрямок виведення задати за допомогою 

трьох прапорців (об'єктів типу CheckBox), розташованих у рамці (Frame). Крите-

рій оцінки – програма повинна працювати! 

 

15.4.  Відповідайте письмово на питання  Принципи сучасної архітектури 

комп’ютерів. 

 

15.5.  Виконайте на ГІС-платформі MapInfo Professional наступну вправу без 

допомоги мультимедійного підручнику: Розміщення на карті даних користува-

ча - геокодування. Результат покажіть викладачу! 

 

15.6.  Відповідайте письмово на питання: Вступ до алгоритмічної мови. Стру-

ктурна організація алгоритмів. 

 

15.7.  Виконайте практичну роботу по наповненню БД даними в будь-якій із ві-

домих вам систем керування базами даних. Результат покажіть викладачу! 
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КОРОТКИЙ ГЛОСАРІЙ  

(українсько-англо-російсько-український) 

 

Автоматизована кар-

тографія; automated 

cartography, computer 

aided mapping, CAM; 

автоматизированная 

картография  

Розділ картографії, що охоплює теорію, методоло-

гію і практику створення, оновлення і використан-

ня карт, атласів та інших просторово-часових кар-

тографічних творів в графічній, цифровій і елект-

ронній формах за допомогою автоматичних картог-

рафічних систем та інших технічних і апаратно-

програмних засобів.  

 

Автоматизоване ро-

боче місце;  work 

station, workstation; ав-

томатизированное ра-

бочее место 

 

Окремий набір обладнання та програмного забез-

печення, призначені для автоматизації праці фахів-

ця-картографа, дизайнера електронних схем, опера-

тора систем повітряного судна тощо. Зазвичай, це 

персональний комп'ютер або робоча станція з гра-

фікою та/або відображення тексту, плоттером, ін-

шими периферійними пристроями. Звичайно пра-

цює як частина локальної мережі (LAN) або мере-

жевої робочої станції (WAN) або в автономному 

режимі (автономні робочі станції). 

 

Алгоритм; algorithm; 

алгоритм; А. 

Дискретний набір скінченної кількості правил, що 

регулюють операції щодо первинних джерел даних  

для досягнення бажаного результату роботи про-

грами і таких, що дозволяють чисто механічно ви-

рішити деякі задачі з класу подібних задач. А. по-

винні мати властивості кінцівки, детермінованості, 

визначеності, масовості та результативності. А., 

формалізований засобами мови програмування на-

зивається програмою. 

 

Аналіз близькості; 

neighbourhood analysis, 

proximity analysis; ана-

лиз близости; А.б. 

1. Просторово-аналітична операція, заснована на 

пошуку двох найближчих точок серед заданої їх 

множини і використовується в різних алгоритмах 

просторового аналізу. А.б. включає пошук найбли-
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жчого сусіда (nearest neighbour analysis) однієї з 

точок заданої великої кількості або точки (завдання 

інтерполяції і автоматичної класифікації), що знову 

пред'являється, і використовується для генерації 

полігонів Тисена і побудови тріангуляції Делоне;  

2. В ГІС растрового типу: привласнення елементу 

растру нового значення як деякій функції значень 

навколишніх елементів (завдання згладжування, 

фільтрації).  

 

Аналіз видимості/  

невидимості; viewshed 

analysis, 

visibility/unvisibility 

analysis; анализ види-

мости / невидимости 

Просторово-аналітична операція обробки цифрових 

моделей рельєфу,  яка забезпечує оцінку поверхні з 

точки зору видимості або невидимості  окремих її 

частин шляхом виділення зон та побудови карт ви-

димості/невидимості з деякої точки огляду або 

множини точок, заданих в просторі.  

 

Аналогова карта; ana-

logue map; аналоговая 

карта 

 

Карта на папері або пластику на противагу цифро-

вого її подання.  

Аналоговий сигнал; 

analogue signal; анало-

говый сигнал; А.С. 

Форма електричного сигналу або коливального 

процесу, амплітуда і/або частота якого змінюється 

безперервно, тобто сигнал містить інформацію у 

кожний момент часу, а не у певні, дискретні моме-

нти. А.С. піддаються зовнішнім впливам, які мо-

жуть змінювати характер коливання. 

 

Аналогове зображен-

ня; analogue image; 

аналоговое изображе-

ние 

Зображення, на якому безперервні зміни властивос-

тей об'єктів зондування представлено безперервни-

ми змінами тонів зображення. Типовим прикладом 

А.З. є фотографічне зображення. 

 

Апаратно-програмне 

забезпечення; 

software/hardware, 

Синонім: програмно-апаратне забезпечення, сукуп-

ність програмного та апаратного забезпечення сис-

теми  обробки інформації.  
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"hard and soft"; аппа-

ратно-программное 

обеспечение   

 

 

 

 

База даних, БД; data 

base, database, DB; база 

даннях. 

Сукупність даних, організованих за певними пра-

вилами, що встановлюють загальні принципи опи-

су, зберігання і маніпулювання даними. Зберігання 

даних у БД забезпечує централізоване управління, 

дотримання стандартів, безпеку і цілісність даних, 

скорочує надмірність і усуває суперечність даних. 

БД не залежить від прикладних програм. Створен-

ня БД і звернення до неї (по запитах) здійснюються 

за допомогою системи керування базами даних 

(СКБД). Робочі станції локальної обчислювальної 

системи (ЛОС) виступають в ролі клієнтів, а сервер 

БД повністю обслуговує запити (як правило, запи-

сані на мові SQL) і посилає клієнтам результати, 

реалізовуючи технологію клієнт-сервер 

(client/server). БД ГІС містять набори даних про 

просторові об'єкти, утворюючи просторові БД 

(spatial database); цифрова картографічна інформа-

ція може організовуватися в картографічні бази да-

них (map database), картографічні банки даних. 

 

Байт; byte, octet, 8 - bit 

byte; байт; б. 

1. Найменша одиниця даних або пам'яті, що адре-

сується, ЕОМ, що обробляється зазвичай як єдине 

ціле; якщо не передбачається інше, дорівнює 8 бі-

там; чотири біта, що займають праву або ліву поло-

вину б., називаються тетрадою або півбайтом 

(nibble, nybble).  

2. Одиниця виміру об'єму пам'яті і місткості при-

строю (capacity) і основа похідних одиниць: 1 кіло-

байта (Кбайта, К), рівного 1024 байтам, 1 мега-

байта (Мбайт, М), рівного 1024 Кбайтам, 1 гіга-

байта (Гбайт, Г), рівного 1024 Мбайтам, 1 тера-

байта (Тбайт, Т), рівного 1024 Гбайтам, 1 пета-
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байта, рівного 1024 Тбайтам. 

 

Біт; bit, binary digit; 

бит 

Одна з цифр: 0 або 1 – при представленні числа в 

двійковій системі числення; мінімальна одиниця 

кількості інформації в ЕОМ, рівна одному двійко-

вому розряду; набір з, як правило, восьми бітів но-

сить назву байта. 

 

Буферна зона; buffer 

zone, buffer, corridor; 

буферная зона; Б.з. 

Шар, утворений шляхом розрахунку і побудови ек-

відистант або еквідистантних ліній (equidistant 

line), рівновіддалених відносно безлічі точкових, 

лінійних або полігональних просторових об'єктів. 

Операція "буферизації" (buffering) використовуєть-

ся, наприклад, для цілей виділення 200-мильної 

економічної зони узбережжя, 100-метрової смуги 

відчуження транспортної магістралі і тому подібне. 

Б.з. полігонального об'єкту може будуватися зовні і 

усередині полігону; якщо відстані між об'єктами і 

еквідистантами ставляться у відповідність значення 

одного з його атрибутів, говорять про "буфериза-

цію" з "зважуванням" (weighed buffering). 

 

Векторне подання; 

vector data structure, 

vector data model; век-

торное представление; 

В.п. 

Цифрове подання точкових, лінійних і полігональ-

них просторових об'єктів у вигляді набору коорди-

натних пар, з описом тільки геометрії об'єктів, що 

відповідає нетопологічному В. п. лінійних і поліго-

нальних об'єктів (див. модель "спагетти") або гео-

метрія і топологічні відношення (топологія) у ви-

гляді векторно-топологічного подання; в машинній 

реалізації В. п. відповідає векторному формату 

просторових даних (vector data format). 

 

Візуалізація; 

visualization, 

visualisation, viewing, 

display, displaying; ви-

В ГІС, комп'ютерній графіці і картографії – проек-

тування і генерація зображень, у тому числі гео-

зображень, картографічних зображень і іншої гра-

фіки на пристроях відображення (переважно на ек-
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зуализация рані дисплея) на основі початкових цифрових да-

них, правил і алгоритмів їх перетворення. Можли-

вості проектування і редагування зображень вклю-

чають набір інструментальних засобів і операцій ві-

зуалізації, включаючи масштабування зображення 

(zooming), тобто його зменшення (reducing, zoom in) 

і збільшення (enlarging, zoom out), кратне цілому 

або таке, що задається користувачем, або укруп-

нення деталей обраного фрагмента в межах прямо-

кутного вікна (windowing), панорамування, тобто 

розгортання зображення до розмірів робочої части-

ни відеоекрану або його активного вікна (pan); про-

крутку, або скролінг (scrolling) зображення, розмір 

якого перевищує габарити відображення; перегор-

тування, або покадровий перегляд, браузинг, броу-

зинг (browsing) багатошарового набору або послі-

довності зображень; зміщення, переміщення, дуб-

лювання, відсікання (кліппування), поворот (рота-

цію) і інші графічні або геометричні перетворення.  

 

Геозображення; 

geoimage, 

georepresentation; гео-

изображение 

Будь-яка просторово-часова масштабна генералізо-

вана модель земних об'єктів або процесів, предста-

влена в графічній образній формі. Розрізняють: 

двовимірні плоскі Гз. (2D geoimages, flat geoimages) 

напр., карти, плани, електронні карти, aэро - і кос-

мічні знімки; тривимірні, або об'ємні Гз.  (3D 

geoimages, volumetric geoimages), напр., стереомо-

делі, анагліфи, блок-діаграми, картографічні голог-

рами; динамічні Гз. (dynamic geoimages), це аніма-

ції, картографічні фільми, мультимедійні карти і 

атласи. 

 

Геоінформатика;   

computer science, geoin-

formatics; геоинфор-

матика 

Наука, технологія і виробнича діяльність з науко-

вого обґрунтування, проектування, створення, екс-

плуатації і використання географічних інформацій-

них систем, по розробці геоінформаційних техно-
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логій, по прикладних аспектах, або застосуваннях 

ГІС (GIS application) для практичних або наукових 

цілей. Є складовою частиною геоматики (за однією 

з точок зору) або предметно і методично перетина-

ється з нею. 

 

Графічний інтерфейс 

користувача; graphical 

user interface, GUI; 

графический интер-

фейс пользователя. 

Графічне середовище організації взаємодії корис-

тувача з обчислювальною системою. До основних 

елементів Г. і. к. відносять: вікна, меню, лінійки ін-

струментів, або інструментальні лінійки, планки ін-

струментів (tool bar), набори піктограм, вибір яких 

ініціює яку-небудь дію, лінійки прокрутки (scroll 

bar), і елементи управління (controls), що є: кнопки 

(buttons), у тому числі кнопки команд (command 

buttons), кнопки налаштування (options buttons), пе-

ремикачі (radio buttons), набори значень (value sets), 

вимикачі (check box), списки (list box), текстові зони 

(text box), спінери (spinners) та ін. 

 

Запит; query, request; 

запрос. 

Завдання на пошук (retrieval) даних у базі даних, 

що задовольняють деяким умовам. З. формулюєть-

ся за допомогою мови спілкування користувача з 

СКБД мови запитів (query language), З. за шабло-

ном (query - by - example, QBE) або іншим спосо-

бом. В процесі виконання З. можуть виконуватися 

додаткові дії (якщо це дозволяє мову З.): сортуван-

ня, обчислення і ін. Стандартна мова З. реляційних 

СКБД - SQL. Пошук просторових об'єктів за умо-

вами, що містять координати, здійснюється по про-

сторовому З. (spatial query) на пошук об'єктів у вік-

ні прямокутної, круглої або довільної форми. 

 

Комп'ютер; computer; 

компьютер. 

Електронна (цифрова) обчислювальна машина – 

ЕОМ – комплекс технічних засобів, призначених 

для автоматичної обробки інформації в процесі рі-

шення обчислювальних і інформаційних завдань. 



 52 

За конструктивними особливостями, функціональ-

ними можливостями, продуктивністю і експлуата-

ційними характеристиками розрізняють персональ-

ні К., робочі станції, К. загального призначення, 

або універсальні К., "мейнфрейми" (mainframe). 

СУПЕРЕОМ, суперкомп'ютер (supercomputer) об-

числювальна машина, продуктивність якої знахо-

диться на межі технічних можливостей свого часу. 

 

Комп'ютерна карта;  

computer map; компь-

ютерная карта; К.к. 

Карта, отримана за допомогою засобів автоматизо-

ваного картографування або засобів ГІС із допомо-

гою пристроїв графічного виводу: графічних при-

строїв, принтерів та ін., на папері, пластиці, фотоп-

лівці і інших матеріалах. Іноді до К. к. відносять 

також карти, виготовлені на неспеціалізованих 

приладах, напр., на алфавітно-цифрових друкуючих 

пристроях, т. н. ЕОМ-карти, або АЦДП-карти (line 

printer map).  

 

Координати; 

сoordinates; координа-

ты. 

Числа, завданням яких визначається положення то-

чки на площині, поверхні або в просторі. Прямо-

кутні, або декартові координати (grid сoordinates, 

rectangular сoordinates, right - angled сoordinates, 

Cartesian сoordinates) – це 1) прямокутні координа-

ти на площині (planimetric rectangular сoordinates, 

2D сoordinates, two dimensional сoordinates) - забез-

печені знаками + або - відстані X (абсциса) і Y (ор-

дината) цієї точки від двох взаємно перпендикуля-

рних прямих Х і У, такі, що є координатними осями 

(X - axis, Y - axis) і такі, що пересікаються в деякій 

точці - на початку К. (сoordinates origin) і 2) прямо-

кутні координати в просторі (rectangular space 

coordinates, spatial coordinates, 3D сoordinates, three 

dimensional сoordinates) – три числа x, y і z (апліка-

та), які визначають положення точки відносно 

трьох взаємно перпендикулярних площин. 
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Меню; menu; меню Зображення на відеоекрані списку команд, їх пара-

метрів і інших можливостей (опцій) для вибору ко-

ристувачем наступної дії системи шляхом вказівки 

ним вибраної опції засобами управління курсором: 

клавішами клавіатури, маніпулятором типу "миша" 

або іншим пристроєм управління; один з основних 

елементів графічного інтерфейсу користувача один 

із засобів реалізації інтерактивного режиму взаємо-

дії користувача з обчислювальною системою на ві-

дміну від командного інтерфейсу (command, 

command mode). 

 

Монітор; monitor; 

монитор. 

Пристрій, що використовується для контролю про-

цесів і управління обчислювальною системою. Ди-

сплей і клавіатура можуть застосовуватися як пульт 

управління і як М .; дисплей без клавіатури – тіль-

ки як М., - для нагляду за системою на відстані. 

 

Оверлей; overlay;  

оверлей. 

Операція накладення один на одного двох або 

більш шарів, в результаті якої утворюється графіч-

на композиція, або графічний оверлей початкових 

шарів (graphic overlay) або один похідний шар, що 

містить композицію просторових об'єктів початко-

вих шарів, топологію цієї композиції і атрибути, 

арифметично або логічно похідні від значень атри-

бутів первинних об'єктів в топологічному О. 

(topological overlay) векторних моделей просторо-

вих об'єктів. 

 

Операційна система, 

ОС; operating system, 

OS; операционная си-

стема. 

Програмний комплекс, що забезпечує підтримку 

роботи всіх програм і їх взаємодію з апаратними 

засобами і користувачем. ОС управляє пам'яттю, 

введенням-виведенням, зовнішньою пам'яттю, вза-

ємодією процесів, здійснює захист, облік викорис-

товування ресурсів, обробку командної мови. 
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Персональний ком-

п'ютер, ПК; реrsonal 

computer, PC; персо-

нальный компьютер.  

Комп'ютер, розрахований на використовування од-

нією людиною, такий, що забезпечує  індивідуаль-

ного користувача всіма необхідними йому засоба-

ми обчислення; настільна мікро-ЕОМ, що має екс-

плуатаційні характеристики побутового приладу і 

універсальні функціональні можливості. 

 

Піксел; pixel; пиксель. Елемент зображення, якнайменша з його складо-

вих, одержувана в результаті дискретизації зобра-

ження (розбиття на далі неподільні елементи – дік-

рети, осередки, чарунки або точки растру); харак-

теризується прямокутною формою і розмірами, ви-

значаючими просторову роздільну здатність. 

 

Піктограма; icon; 

пиктограмма. 

Маркер – невелике растрове зображення на відеое-

крані для ідентифікації деякого об'єкту (файлу, 

програми і т.п.), вибір і активізація якого викликає 

деяку дію; один з елементів графічного інтерфейсу 

користувача. Може використовуватися як умовний 

знак і елемент картографічного зображення і леген-

ди карти при реалізації способу значків. 

 

Програма; program, 

routine; программа. 

1. Дані, призначені для управління конкретними 

компонентами системи обробки даних в цілях реа-

лізації певного алгоритму;   

2. Впорядкована послідовність команд, що підля-

гають обробці, послідовність пропозицій мови про-

грамування (programming language). 

 

Процесор; processor; 

процессор. 

Функціональна частина обчислювальної машини 

(комп'ютера) або системи обробки інформації, при-

значена для інтерпретації програм. 

 

Растр; raster, dot pat-

tern; растр. 

 

Прямокутна решітка, основа растрової моделі про-

сторових даних; характеристиками Р. є кількість 

рядків та стовпців, розмір комірки.  
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Растрова модель; ras-

ter model; растровая 

модель. 

Растровий спосіб подання просторових даних, спо-

сіб формалізації просторових даних за елементами 

(чарунками) растра.  

  

Система керування 

базами даних, СКБД; 

data base management 

system, DBMS; система 

управления базами              

данных. 

Комплекс програм і мовних засобів, призначених 

для створення, ведення і використання баз даних. 

СКБД підтримують, як правило, одну з трьох най-

поширеніших моделей (схем) даних: реляційну 

(relational data model), ієрархічну (hierarchical data 

model) або мережну (network data model). Більшість 

сучасних комерційних СКБД відноситься до реля-

ційного типу. 

 

Сцена; scene; сцена. 1. В комп'ютерній графіці: тривимірний простір, що 

візуалізується, з розташованими в ньому об'єктами; 

2. В дистанційному зондуванні: частина території, 

що потрапила до поля зору знімальної апаратури і 

реєстрована нею у вигляді аналогового або цифро-

вого зображення. 

 

Тріангуляція Делоне; 

Delaunay triangulation; 

триангуляция Делонэ. 

Трикутна полігональна мережа, утворювана на без-

лічі точкових об'єктів шляхом їх з'єднання непере-

січними відрізками і що використовується, зокрема, 

в тріангуляційній моделі при створенні цифрової 

моделі рельєфу. 

 

Формат; format;  

формат. 

1. Спосіб розташування або подання даних в пам'я-

ті, базі даних, документі або на зовнішньому носії; 

2. В ГІС, машинній графіці і обробці зображень: за-

гальне найменування способу машинної реалізації 

представлення (моделі) просторових даних (векто-

рний Ф., растровий Ф. і т.п.) або Ф. даних конкрет-

ної системи, програмного засобу, засоби стандарти-

зації, обміну даними. 
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Цифрова карта; digital 

map; цифровая карта. 

Цифрова модель звичайної карти, створена шляхом 

оцифрування картографічних джерел, фотограмме-

тричної обробки даних дистанційного зондування, 

цифрової реєстрації даних польових зйомок або 

іншим способом. 

 

Центральний проце-

сор; central processing 

unit; центральный 

процессор. 

 

Електронна мікросхема, призначена для здійснення 

обчислень, покрокового виконання інструкцій, 

обумовлених програмою, яка виконується. 

Чарунка (комірка); 

сеll, grid сеll, tile; 

ячейка. 

Синонім: регулярна чарунка – двомірний просторо-

вий об'єкт, елемент розбиття земної поверхні лінія-

ми регулярної мережі, тобто регулярно-

комірчастого представлення просторових об'єктів, 

на відміну від піксела (як елементу растрового по-

дання), утворюваного розбиттям лініями растру зо-

браження (а не земної поверхні). 
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ЛИСТ ОСНОВНИХ СКОРОЧЕНЬ 

 

АМ - алгоритмічна мова 

АОІТ - арифметичні основи інформаційних технологій 

БД ГІС - база даних геоінформаційної системи  

ВМК - вихідний модульний контроль  

ГІС - геоінформаційна система 

ДЗ - домашнє завдання 

ЕОМ  - електронно-обчислювальна машина 

ІТ - інформаційні технології  

ЛОІТ - логічні основи інформаційних технологій 

ОС - операційна система 

ПМК - підсумковий модульний контроль 

СКБД - система керування базами даних 
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Навчально-методичне видання 

 

Навчально-методичний комплекс 

 

  

Костріков С.В., Бережний В.А., Добровольська Н.В., Сегіда К.Ю. 
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